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Preface
VMS Software, Inc. (VSI) is an independent software company licensed by Hewlett Packard Enterprise
to develop and support the OpenVMS operating system.

1. Introducing OpenVMS x86-64 V9.2-2
This manual provides instructions for booting and installing (or upgrading to) VSI OpenVMS for x86-64
Version 9.2-2 (hereafter referred to as OpenVMS x86-64 V9.2-2) using an ISO file on guest virtual
machines.

2. Intended Audience
Users of this manual are expected to obtain and reference any additional documentation specific to their
hardware and environment. Users are expected to know how to identify the various devices involved in
their installation and be familiar with the console commands that are available on their system and virtual
machines.

Users should be familiar with the virtual machine environments they plan to use for running OpenVMS
x86-64 V9.2-2 as a guest virtual machine.

Make sure you read the Release Notes, Installation Guide, and Boot Manager Guide prior to installing
OpenVMS x86-64 V9.2-2.

3. Using the VSI Customer Portal
See the OpenVMS x86-64 V9.2-2 announcement email for information about how to log issues against
the V9.2-2 release and how to use the VSI Services Portal at https://sp.vmssoftware.com.

4. Other Related Documentation
● VSI OpenVMS x86-64 V9.2-2 Release Notes [https://docs.vmssoftware.com/vsi-openvms-x86-64-

v922-release-notes/]

● VSI x86-64 Cross-tools Kit Installation and Startup Guide (for VSI OpenVMS V9.2-2) [https://
docs.vmssoftware.com/vsi-x86-64-cross-tools-kit-installation-and-startup-guide-v922/]

● VSI OpenVMS Linker Manual [https://docs.vmssoftware.com/vsi-openvms-linker-utility-manual/]

● VSI Calling Standard Manual [https://docs.vmssoftware.com/vsi-openvms-calling-standard/]

● VSI OpenVMS x86-64 Boot Manager User Guide [https://docs.vmssoftware.com/vsi-openvms-
x86-64-boot-manager-user-guide-922/]

● VSI OpenVMS TCP/IP Services V6.0 documentation at the VSI Documentation portal [https://
docs.vmssoftware.com/]

● Third-party documentation as cited throughout this document
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Chapter 1. Preparing to Install VSI
OpenVMS x86-64 V9.2-2
1.1. Tested Platforms
For information about supported virtual environments, see https://vmssoftware.com/about/v922/.

Important

Note that not all VMware license types are currently supported for running VSI OpenVMS x86-64
V9.2-2. For more information, see VSI OpenVMS x86-64 V9.2-2 Release Notes.

1.2. Platforms Documentation
Due to the many third-party platform products that you can use with VSI OpenVMS x86-64 V9.2-2,
VSI cannot provide the complete documentation for these products. The following table lists each
product and a URL to its documentation web site:

openSUSE Leap https://doc.opensuse.org/
Oracle Linux https://docs.oracle.com/en/operating-systems/oracle-linux/8/
Oracle VirtualBox https://www.virtualbox.org/wiki/End-user_documentation
Rocky Linux https://docs.rockylinux.org/
Ubuntu https://help.ubuntu.com/
VMware ESXi Enterprise https://docs.vmware.com/en/VMware-vSphere/index.html
VMware Fusion https://docs.vmware.com/en/VMware-Fusion/index.html
VMware Workstation Player https://docs.vmware.com/en/VMware-Workstation-Player/

index.html
VMware Workstation Pro https://docs.vmware.com/en/VMware-Workstation-Pro/index.html

1.2.1. Recommended Settings for Virtual Machines
While the actual configuration of the VM should reflect your expected system usage, the expected
system usage might be a hard thing to predict. However, the benefit of using a virtual machine is that
you can always reconfigure it as needed for the current situation. VSI recommends that your OpenVMS
x86-64 virtual machine be configured with the following minimum settings:

● CPU that meets the following requirements:

○ Intel or AMD x86 CPU

○ 64-bit Instruction set

○ NX processor bit (NX)

○ Streaming SIMD Extensions 4.1 (SSE4.1)

1
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Chapter 1. Preparing to Install VSI OpenVMS x86-64 V9.2-2

○ Virtualization Technology (VT-x)

○ XSAVE instructions

○ Time Stamp Counter (TSC)

○ Advanced Programmable Interrupt Controller (APIC)

○ Memory Type Range Registers (MTRR)

Most Intel CPUs from 2016/AMD (Zen) CPUs from 2017 and later support these processor features.

● Memory: 8 GB.

Note that if your installation fails due to the lack of memory, you can increase the amount of it for
the duration of the installation and then, if needed, reduce it back.

● Operating system: Other 64-bit.

● A virtual disk for the system files. The disk must be at least 15 GB in size (for the supported
disk types, see the VSI OpenVMS x86-64 V9.2-2 Release Notes [https://docs.vmssoftware.com/
vsi-openvms-x86-64-v922-release-notes/]). Optionally, if the disk space for the system files is
limited, consider using a dump off system disk (DOSD) as described in the VSI OpenVMS x86-64
V9.2-2 Release Notes [https://docs.vmssoftware.com/vsi-openvms-x86-64-v922-release-notes/]. The
minimum disk size for the DOSD must at least be equal to the amount of RAM that your VM has.

● Boot Option:

○ Disable Secure Boot (if present).

○ Enable UEFI or EFI (BIOS is not supported).

● Console Communication: serial port using a raw TCP connection for VMWare and Virtual Box, or
virsh for KVM VMs.

Note

Currently, only COM1 serial port is supported.

● An additional serial line for non-console login.

● Network: Adapter Type or Device Model of e1000 (ESXi or KVM); 82540EM (VirtualBox).

Note

VSI strongly advises against manual configuration of DECnet MAC address on any interface.

● CD/DVD device (physical or virtual) with the OpenVMS installation kit (the .ISO file) assigned to
it.

● Minimum number of CPUs: 2.

● Chipset, where offered: ICH9 (VirtualBox); Q35 (KVM).
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Chapter 1. Preparing to Install VSI OpenVMS x86-64 V9.2-2

1.3. Licensing
During the installation, you will be prompted to register Product Authorization Keys (PAKs) for the base
operating environment and any layered products that are not already included in the base OS.

A PAK is represented as a text-structured file containing a series of named fields and unique values that
were generated by VSI. You have the option to register your PAKs during the installation or after the
installation is complete. VSI recommends that you register your PAKs after the installation by renaming
the PAK file(s) that VSI provided with a .COM extension and then executing that file; this will register
all your licenses at once. Thereafter, you must either issue the LICENSE LOAD command or reboot
OpenVMS to make them active. If you choose to register your PAKs during the installation, you can
either type the values of each requested field, or copy-and-paste the values into the console line by line
(assuming your console connection supports this action, such as using a terminal emulator).

Below is an example of what a PAK might look like:

$ LICENSE REGISTER OPENVMS-X86-BOE -
/ISSUER=VSI -
/AUTHORIZATION=1-VSI-SAMPLAUTH-0001 -
/PRODUCER=VSI -
/UNITS=32 -
/TERMINATION_DATE=31-OCT-2023
/OPTIONS=(PCL,X86_64) -
/CHECKSUM=X-XXXX-XXXX-XXXX-XXXX

1.3.1. Using VMware vSphere Hypervisor Licenses
Use the method described below to run VMware vSphere Hypervisor on an ESXi server with a basic
license (not Enterprise or Enterprise Plus). You must use serial ports within the same ESXi server.

Use the named pipe functionality to map COM1/OPA0: on the VMS virtual machine to a pipe on a
management server on which a terminal emulator is installed.

With the VM system in client mode, use the following syntax:

\\.\pipe_name

With the management system in the server mode, use the following syntax: \\.\pipe_name, where
pipe_name is a unique name that you provide for each VM.

Note

For the named pipe connection to work correctly, both the server and client must reside on the host
system.

3



Chapter 1. Preparing to Install VSI OpenVMS x86-64 V9.2-2

The terminal emulator should be set for serial connection at 115200 baud.

The following two figures show how to set up pipes for a local terminal emulator-based console.

The following two figures show how to set up pipes between two local virtual machines where one plays
the role of VMS console. This could be a virtual machine guest running any OS that supports a terminal
emulator.

4
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Chapter 2. Creating and
Configuring a Virtual Machine
This chapter provides basic instructions for creating and configuring a guest virtual machine (VM) on
VMware ESXi, KVM, and Oracle VirtualBox. In these instructions, VSI assumes that the application for
managing the VM guests is already installed and configured.

2.1. Creating a VMware ESXi Virtual Machine
The instructions in this section were written for VMware ESXi 7.0. However, the general principles
described here also apply to other VMware products, such as Workstation and Fusion.

To create a virtual machine on a VMware ESXi host, follow these steps:

1. Download, unzip, and copy the VSI OpenVMS x86-64 V9.2-2 ISO file to an area that is locally
accessible to the browser used to connect to the VMware ESXi host client.

2. In your browser, enter the ESXi host IP address to bring up the VMware ESXi environment. At the
login screen, provide your user credentials and log in.

3. On the left side of the VMware ESXi window, go to Navigator > Storage. On the right side of the
window, click Datastore browser.

4. In the Datastore browser pop-up window, left-click the datastore where you would like to save the
ISO kit, click Upload, and navigate to the ISO kit (which should be on your browser's local system).
Then, click Open.

Note

Once the upload starts, you can close the Datastore browser window.

5. To create a virtual machine using the ISO file, go to the Host menu, then click the Create/Register
VM button.

6. In the New virtual machine window, perform the following steps:

a. On the Select creation type: Create a new virtual machine page, click Next.

b. On the Select a name and guest OS page, specify the following information:

i. Name – set the name for your virtual machine. Keep in mind, the name must be unique in
your environment.

ii. Compatibility – VSI recommends accepting the default value.

iii. Guest OS family – select Other.

iv. Guest OS version – select Other (64-bit).

Сlick Next.

7



Chapter 2. Creating and Configuring a Virtual Machine

c. On the Select storage page, select the datastore that will contain the disk image(s) and files for
your VM. Click Next.

d. On the Customize settings page, click Virtual Hardware and specify values for the following
fields:

i. CPU – set the number of CPUs for your VM (for the values recommended by VSI, refer to
Section 1.2.1, "Recommended Settings for Virtual Machines").

ii. Cores per Socket – select a value appropriate for your VM and licensing needs.

Note

The Sockets field updates automatically depending on the number of cores per socket that
you select.

iii. Memory/RAM – set the appropriate amount of RAM for your VM (for the values
recommended by VSI, refer to Section 1.2.1, "Recommended Settings for Virtual Machines").

iv. SCSI Controller 0 – if this controller does not exist, and you would like to add it to your
VM, click the Add other device button, above the CPU field. Then, select SCSI controller
from the dropdown menu. Then, make sure LSI Logic Parallel is selected from the list.
Other SCSI controllers are not supported in the current release.

SATA Controller 0 – if this controller does not exist, and you would like to add it to your
VM, click the Add other device button, above the CPU field. Then, select SATA controller
from the dropdown menu.

v. Hard disk 1 – select disk type and set the size (for the VSI recommendation, refer to Section
1.2.1, "Recommended Settings for Virtual Machines"). Also, set the following parameters:

A. Controller location on the left side – select the controller you wish to use: SATA or
SCSI.

B. Controller location on the right side – select the bus and LUN assignment for your disk
(or accept the default value).

Note

If you are using a version of VMware ESXi earlier than 8, make sure not to use the same
bus/LUN setting for any of your disks and/or CD-ROMs. ESXi 8 automatically sets
different LUNs if they accidentally coincide.

C. Disk Provisioning – select the Thick provisioned, lazily zeroed option.

vi. To add an additional disk, perform the following steps and specify the following settings:

A. Click the Add hard disk button just above the CPU field.

B. Select New standard hard disk.

8



Chapter 2. Creating and Configuring a Virtual Machine

C. New Hard disk – select disk type and set the size.

I. Controller location on the left side – select the controller you wish to use: SATA or
SCSI.

II. Controller location on the right side – select the bus and LUN assignment for your
disk (or accept the default value).

Note

Make sure not to use the same bus/LUN setting for any of your disks and/or CD-
ROMs.

D. Disk Provisioning – select the Thick provisioned, lazily zeroed option.

vii. Network Adapter 1 – ensure the correct adapter is selected from the drop-down list. The
correct adapter depends on your environment.

● Adapter Type – select E1000 from the list.

viii.CD/DVD Drive 1 – select the Datastore ISO file value.

A. In the Datastore browser pop-up window, navigate to the VSI OpenVMS ISO file that
you downloaded earlier and click Select.

B. CD/DVD Media – ensure the path to the ISO is correct.

C. Controller location on the left side – ensure the correct controller is selected for the new
disk.

D. Controller location on the right side – select the bus and LUN assignment for the new
hard disk.

ix. Set up a serial port for your VM, so that you can connect to it later using a terminal emulator.
If you are using VMware ESXi, you will have to map this serial port to a valid TCP/IP port.
If you are using any other VMware product as your hypervisor of choice, you may need to
use a named pipe connection. Both methods are described below. Follow these steps:

A. Click Add other device.

B. Select Serial port.

C. From the New Serial Port dropdown list, select Use network if you plan to use you
serial port with a TCP/IP port. If you plan to use your serial port with a named pipe,
select Use named pipe.

Note

Note that using named pipes requires that your terminal utility reside on your VM host
system. To use named pipes over a different network node, you will need to use a Named
Pipe Proxy server.

D. If you selected Use network in the previous step, type tcp://<your ESXi host
IP>:<port ID> in the Connection Port URI field. The port ID must be unique on 9
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the ESXi host. Once you are satisfied with the URI, click anywhere in the window to
validate the URI format and remove the warning.

If you selected Use named pipe, type \\.\pipe\pipe_name in the Pipe name
field. The pipe name must be unique for each VM.

E. Connection Direction – ensure Server is selected.

e. On the Customize settings page, click VM Options and specify the following information:

i. Click Boot Options to expand the settings.

iii. Enable UEFI secure boot – make sure this checkbox is not checked.

iv. Force BIOS setup – make sure this checkbox is checked.

v. Click Next.

f. On the Ready to complete page, review the settings. If everything is correct, click Finish.

2.1.1. Completing Your VMware ESXi Virtual Machine
Configuration
1. Once you have created your VM, go to the Virtual Machines area in the VMware ESXi

environment and select the VM you created.

Warning

Attempting to perform the next steps before your VM is fully created will result in an unusable VM.

2. Edit the settings for your VM. Click the VM Options button.

a. Navigate to Boot Options > Firmware and set the value to EFI.

b. Navigate to Advanced > Configuration Parameters and from the Edit Configuration set the
following parameters accordingly.

Key Value

efi.quickBoot.enabled FALSE
efi.serialconsole.enabled TRUE
efi.shell.activeByDefault TRUE

Note

If you are using a version of VMware ESXi earlier than 8, make sure your capitalization is done
as specified in the table above.

c. Click Save.

3. Your VM information, hardware configuration, and power controls will now be displayed. Click the
Power on button at the top.10
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4. After the power on process is successfully completed, you will see the blue BIOS screen of your VM
in the console preview pane in the top left.

Note

On VMware ESXi 8, when an OpenVMS VM is launched, it immediately enters the boot manager
instead of the BIOS. To get into BIOS, you need to force log in by enabling the following setting:

Navigate to VM Options > Boot Options > Force BIOS Setup . The next time the virtual machine
boots, force entry into the BIOS setup screen.

With VMware ESXi 8, proceed to Section 2.2, "Creating a KVM/QEMU Virtual Machine".

5. Click anywhere in the console preview pane to open up the ESXi browser console to the VM. The
platform Boot Manager screen will be displayed. If needed, configure the screen size (in the menu,
navigate to Boot Manager screen > Enter setup > Configure screen size > Set screen size >
Commit changes and exit > Exit Boot Maintenance Manager).

6. Navigate to Enter setup > Configure boot options > Enable or disable boot options screen and
disable all lines except the EFI Internal Shell (Unsupported option). An example is shown below.

7. Select Commit changes and exit > Exit the Boot Maintenance Manager.

8. From the Boot Manager screen, select EFI Internal Shell (Unsupported option), and press Enter.

Note

On ESXi, some users may experience problems when trying to establish a connection to a VMware
console. To remedy this, you must enable a firewall rule by following the steps below:

1. Display the ESXi firewall rule for remoteSerialPort using the command:

esxcli network firewall ruleset rule list -r remoteSerialPort

2. Enable the rule by using the command:

esxcli network firewall ruleset set -r remoteSerialPort -e true

For information about working with ESXi firewall, refer to the official VMware documentation.

Your virtual machine is now ready to have VSI OpenVMS x86-64 installed on it. See Chapter 3,
"Installing and Upgrading VSI OpenVMS x86-64 V9.2-2 on a Guest Virtual Machine".

11
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2.2. Creating a KVM/QEMU Virtual Machine
Note

The following instructions have been written for KVM/QEMU 5.2.

To create a virtual machine on KVM/QEMU, follow these steps:

1. Download, unzip, and copy the VSI OpenVMS x86-64 V9.2-2 ISO file to an area that is locally
accessible to the KVM host server.

2. Run the Virtual Machine Manager and select File > New Virtual Machine from the main menu.
The Create a new Virtual Machine wizard opens.

3. Select Local install media (ISO image or CDROM) and click Forward.

4. Click Browse.

5. In the Locate ISO media volume window, click the Browse Local button, then navigate to the VSI
OpenVMS V9.2-2 ISO file, select it, and click Open.

6. Uncheck the Automatically detect from the installation media/source box, type in the search
box Generic, and select the value that has the words 'unknown' or 'generic' in parenthesis. Click
Forward.

7. Select the amount of memory and number of CPUs to use for your VM (for the values
recommended by VSI, refer to Section 1.2.1, "Recommended Settings for Virtual Machines"). Click
Forward.

8. The Create a disk image for the virtual machine option is selected by default. Set the disk size
for your VM (for the values recommended by VSI, refer to Section 1.2.1, "Recommended Settings for
Virtual Machines"). Click Forward.

Note

If you don't want your images to be saved in the default directory /var/lib/libvirt/images
with default file names, click Select or create custom storage, then click Manage, and create your
desired storage volumes for your VM disk images. Be sure to select the desired volume, then click
Choose Volume.

9. Give your virtual machine a name, review your VM's settings, and check the Customize
configuration before install checkbox. Click the arrow next to Network Selection and verify your
system is using a Bridge device with the appropriate Device name. Then, click Finish.

2.2.1. Completing Your KVM/QEMU Virtual Machine
Configuration
1. Once you have created your VM, a <VM_name> on QEMU/KVM window opens. Then, set the

following settings:

a. Go to Overview, set the following settings:

i. From the Chipset dropdown, select Q35.

12
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ii. From the Firmware dropdown, select the most basic UEFI x86_64:/usr/share/*code.*
option.

iii. Click Apply.

b. If you wish to use SCSI disks, click the Add Hardware button located at the lower left.

i. Go to Controller.

ii. From the Type drop-down list, select SCSI.

iii. Ensure the Model drop-down list is set to VirtIO SCSI.

iv. Click Apply.

c. Go to IDE Disk 1 > Disk bus.

i. For the Disk bus, select either SATA or SCSI, whichever is appropriate for your
environment. Other disk controller types are currently not supported.

ii. Click Apply.

d. To add an additional disk (as recommended by VSI, see Section 1.2.1, "Recommended Settings
for Virtual Machines"), click the Add Hardware button in the lower left corner of the screen,
then perform the following steps:

i. Go to Storage.

ii. Select either one of the two options:

● Select or create custom storage – will allow you to create a disk volume and specify the
desired storage location, size, name, and disk format.

A. Click Manage.

B. On the left side of the Locate or create storage window, select the storage pool that
you want to use or create a new one by clicking the button below the list.

C. After selecting the storage pool, go to the central area of the Locate or create
storage window and click the button to add a volume.

D. In the Add a Storage Volume window, specify the name, format, and capacity for
the storage volume.

E. Enable the Allocate entire volume now checkbox.

F. Click Finish.

G. Select your volume and click Choose Volume.

iii. Make sure that Device type: is set to Disk device.

iv. Select either SCSI or SATA from the Bus Type drop-down list. Other disk controller types
are currently not supported.

13
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v. Click Finish.

vi. Repeat these steps for each additional disk you wish to add to your configuration.

e. Go to IDE CDROM 1.

i. To specify Source path, click Browse, navigate to the VSI OpenVMS V9.2-2 ISO file, and
select it. Then, click the Choose Volume button.

ii. For the Disk bus, select either SATA or SCSI, whichever is appropriate for your
environment. Other disk controller types are currently not supported.

iii. Click Apply.

f. When you have created and configured your devices, go to Boot Options.

i. Enable the Enable boot menu option.

ii. Check the devices from which you want to boot (CDROM and the system disk, in most
cases).

iii. Click Apply.

2. VSI OpenVMS uses a serial port, so one has to be added on the VM that runs it. To set up the serial
port, click Add Hardware again, then select Serial. Make sure that the Pseudo TTY (pty) type is
selected. Accept the defaults for other parameters.

3. Go to NIC:<your_mac_address>

a. From the Device model: dropdown, select e1000e.

b. Click the field that shows e1000e and delete the e at the end, so that only e1000 remains.

c. Click Apply.

4. Click Begin Installation.

5. The Virtual Machine Manager Console will now show either the EFI Shell> prompt or the
BOOTMGR> prompt. This depends on the operating system on which KVM is installed and on the
firmware .BIN file that was selected when the VM was created.

6. Regardless of which prompt is displayed, type EXIT and immediately press the ESC key repeatedly
until the blue platform Boot Manager screen is displayed.

7. Navigate to Boot Manager, then select the EFI Internal Shell option, and press ENTER.

8. You will see the EFI Shell prompt now. Enter MAP FS* -B to display just the file systems
available on your VM one page at a time.

9. Inspect this list of file systems and choose the one that maps to the VSI OpenVMS V9.2-2 ISO
file. Since that ISO has been set up as a CDROM, the file system that maps to it will be labeled as
CDROM. As an example, we will assume that the file system we want is FS0:.

10. At the Shell> prompt, enter the following command:

FS0:\efi\vms\vms_bootmgr

14
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11. After this, you should see the VSI Boot Manager screen.

Your virtual machine is now ready to have VSI OpenVMS x86-64 installed on it. See Chapter 3,
"Installing and Upgrading VSI OpenVMS x86-64 V9.2-2 on a Guest Virtual Machine"

2.3. Creating a VirtualBox Virtual Machine
Note

The following instructions have been written for VirtualBox 7.0.

To create a virtual machine in Oracle VM VirtualBox, follow these steps:

1. Run Oracle VM VirtualBox and select Machine > New from the main menu. The Create Virtual
Machine wizard opens.

2. On the Virtual machine Name and Operating System page of the wizard, do the following:

a. Set the Name and Folder for your VM.

b. In the ISO Image field, specify the path to your OpenVMS ISO file.

c. In the Type dropdown, select Other.

d. In the Version dropdown, select Other/Unknown (64-bit).

e. Click Next.

3. On the Hardware page of the wizard, set the Base Memory for your virtual machine (for the values
recommended by VSI, refer to Section 1.2.1, "Recommended Settings for Virtual Machines"). Click
Next.

4. On the Virtual Hard disk (for the values recommended by VSI, refer to Section 1.2.1,
"Recommended Settings for Virtual Machines") set the size of your virtual hard. Make sure the
preallocate full size option is enabled. Click Next.

5. Click Finish.

You have created your VirtualBox virtual machine. Now, you must properly configure it before you can
install VSI OpenVMS x86-64 V9.2-2.
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2.3.1. Completing Your VirtualBox Virtual Machine
Configuration
To prepare your virtual machine for VSI OpenVMS x86-64 installation, follow these steps:

1. Once you have created your VM, right-click it and select Settings from the menu.

2. In the Settings window, do the following:

a. Go to System > Motherboard and specify the following settings:

i. From the Chipset dropdown, select ICH9. If you select any other chipset, OpenVMS will
not install.

ii. Make sure the Enable I/O APIC and Enable EFI options are checked.

Note

Your virtual machine must boot from UEFI, not BIOS.

b. Go to Storage.

In the Storage Devices area of the Settings window, you will see the default IDE controller and
two devices: the hard disk that you created in the previous topic and the optical drive containing
the VSI OpenVMS V9.2-2 ISO file. IDE disk controllers are currently not supported, so you
must change the controller type to either AHCI (SATA) or LsiLogic. To do so, perform the
following steps:

i. Click the IDE controller to select it.

ii. In the Attributes area on the right side of the Settings window, select AHCI or LsiLogic
from the Type dropdown list.

iii. To avoid confusion in the future, enter an appropriate name in the Name field.

iv. Click the hard disk to display its attributes and make sure that it is now marked appropriately
as SATA or LsiLogic.

v. Click the optical drive to display its attributes and make sure that it is now marked
appropriately as SATA or LsiLogic.

c. Go to Network.

i. Click the Attached to dropdown and select Host-only Adapter.

ii. Сlick Advanced.

iii. From the Adapter type dropdown, select Intel PRO/1000 MT Server.

d. Go to Serial Ports. Your VM must have an active serial port, so that you can connect to it later
using a terminal emulator.

i. Check Enable Serial Port.16
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ii. Set Port Mode to TCP.

iii. Uncheck Connect to existing pipe/socket.

iv. In the Path/Address field, type the port number that you want to use. In this example, we
will use port 2023.

e. Click OK to apply the changes and close the Settings window.

Your virtual machine is now ready to have VSI OpenVMS x86-64 installed on it. See Chapter 3,
"Installing and Upgrading VSI OpenVMS x86-64 V9.2-2 on a Guest Virtual Machine".
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Chapter 3. Installing and
Upgrading VSI OpenVMS x86-64
V9.2-2 on a Guest Virtual Machine
This chapter provides instructions on booting and installing VSI OpenVMS V9.2-2 on a guest VM,
regardless of which hypervisor you are using.

For the first installation of VSI OpenVMS as a guest VM, continue with section Section 3.1, "Installing
VSI OpenVMS x86-64 V9.2-2". For upgrading an existing VMS installation on a VM, skip to Section 3.2,
"Upgrading to VSI OpenVMS x86-64 V9.2-2".

3.1. Installing VSI OpenVMS x86-64 V9.2-2
Before you install VSI OpenVMS x86-64 V9.2-2 on your virtual machine, ensure it has been created
and configured as directed in Chapter 2, "Creating and Configuring a Virtual Machine" of this
document. Once you have created and powered on your VM (or clicked Begin Installation if you are
using QEMU/KVM), follow these steps:

1. Depending on your hypervisor of choice and the boot options settings of your VM, you will either
see the UEFI Shell> prompt:

or the VSI Boot Manager screen:
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2. If you see the UEFI Shell> prompt, do the following:

a. At the Shell> prompt, enter MAP FS* -B to display all the file systems available on your
VM. The -B option will display the entries one page at a time if more than a page-worth exists.

b. Choose the file system that maps to the VSI OpenVMS V9.2-2 ISO file. Since that ISO has been
set up as a CDROM, the file system that maps to it will be labeled as CDROM as well. As an
example, we will assume that the file system we want is FS0.

c. At the Shell> prompt, enter FS0:\efi\vms\vms_bootmgr.

After this, you should see the VSI Boot Manager screen.

3. At the BOOTMGR> prompt, type DEVICES to display the list of available VMS-bootable devices.

4. From the list, identify the device that contains the ISO file with the new version of VSI OpenVMS
(it will be labeled as a CDROM or DVD). Enter BOOT <device_name>, where <device_name>
is the name of the disk that contains your ISO file (not the name of the ISO file itself). As an
example, we enter BOOT DKA100. After the progress meter reaches 100%, you should see the
following screen:

5. Establish a remote connection to your VM via a terminal emulator. Depending on your hypervisor of
choice, VSI recommends using the following methods:

● On VMware hypervisors, you can choose to connect via Telnet or a named pipe, depending on
how you set up your VM earlier (see step 6.4.9 of the Creating a VMware ESXi Virtual Machine
section).

● On KVM, perform the following procedure:

a. Make sure that the serial console is enabled and started on the host server.
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b. Make sure that virsh is connected to the hypervisor that you are using.

c. Start virsh and enter the command console VMname, where VMname is the name of the
VM that you want to connect to.

● On VirtualBox, connect via Telnet using the serial port of your VM (that you set up in step 4 of
the Completing Your VirtualBox Virtual Machine Configuration section) and the IP address of the
host system.

Warning

If you are utilizing VMware Workstation or VMware Fusion as your hypervisor, be advised that
virtual serial port support is not available via the GUI. For more information, refer to the Release
Notes.

Note

If you are on ESXi, make sure that the port used by your VM can go through the ESXi firewall. If
you are having trouble at this stage, contact the ESXi administator in your company.

When the BOOTMGR> prompt appears, your terminal emulator should automatically connect to your
VM. However, if that does not happen, you can initiate command output to the serial port manually
by entering the command:

BOOTMGR> COM n

where n is the serial port number that your VM uses.

6. Upon connecting, you should see the VSI OpenVMS installation menu and/or the Enter CHOICE
or ? for help: (1/2/3/4/5/6/7/8/9/?) prompt:

Note

If this prompt does not appear, and the output appears blank or unchanging, press Enter. The prompt
should now appear. To see the OpenVMS installation menu, type ?, hit Enter, then hit Enter again.

Important

VSI OpenVMS x86-64 V9.2-2 does not support installation menu items number 3, 5, and 7. Also,
do not use item number 6 unless directly instructed otherwise.

7. Enter 1 to start the installation process.

8. Since this a new installation, answer INITIALIZE to the Do you want to INITIALIZE
or to PRESERVE? question.

9. At the Enter device name for target disk: prompt, enter the name of the disk where
you want to install VSI OpenVMS.

To display a list of available devices, enter ?. You can also enter ?? which will display a list of
devices with their volume label and size. As an example, we will enter DKA0:.
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10. At the Enter volume label for target system disk prompt, enter the label that
you want to assign to your system disk. In this example, we will enter systemDisk.

11. You will see the Do you want to enable hard links? question. This choice
is up to you and depends on how you are using or plan to use your OpenVMS setup. For
more information about hard links, see VSI OpenVMS System Manager’s Manual, Volume 1
[https://docs.vmssoftware.com/vsi-openvms-system-manager-s-manual-volume-1-essentials/
#HARD_LINKS].

12. A summary of your choices will be displayed, as well as a prompt asking you to confirm your choice.
Enter YES if no changes are needed or NO to re-enter the disk label and choose for hard-links. For
brevity and readability, similar prompts will not be mentioned again in this document.

13. After the target disk has been initialized and mounted, you will be asked to create the SYSTEM
password. Set and confirm the password for your SYSTEM account. The password must be a
minimum of 15 characters.

Warning

If everything is working correctly, you should not see any characters in your output while you enter
your password.

If you, however, see any output or get an error at this stage, this could be a terminal emulator issue or
a Telnet issue. Make sure that Telnet operates in character mode and that your terminal emulator is
forcing the local echo off.

14. At the Enter SCSNODE: prompt, enter a unique name for your OpenVMS system. As an
example, we will enter x86.

15. Next, you will see the Do you plan to use DECnet? prompt. DECnet is a family of
products that allows OpenVMS systems to communicate with each other (for more information, see
VSI DECnet-Plus for OpenVMS Introduction and User's Guide [https://docs.vmssoftware.com/vsi-
openvms-decnet-plus-introduction-and-user-s-guide/]). This choice is up to you and depends on how
you are planning to use your OpenVMS setup.

Note

If you answer NO, you will be asked to specify a value for the SCSSYSTEMID parameter. This
parameter is an ID number that each OpenVMS system has on a network. Make sure that each
SCSSYSTEMID is unique amongst the systems on your network.

If you answer YES, the value for SCSSYSTEMID will be calculated based on the DECnet address
that you enter when prompted for it.

16. Depending on your response to the previous question, you will be prompted for either the DECnet
IV address, or the SCSSYSTEMID value. Enter a value that is unique in your environment.

17. The next several prompts will ask you to specify the time zone information for your system. Enter
appropriate values.

18. After setting the time zone information, you will see the Do you want to register any
Product Authorization Keys? prompt. VSI recommends that you answer NO and register
your Product Authorization Keys (PAKs) after the installation is complete.
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Important

VSI provides PAKs in the form of text files containing DCL code. You cannot run that code during
the VSI installation. However, if you choose to NOT register your PAKs now, once the installation
has completed and the system has rebooted (twice), you will be able to register your PAKs all at
once by creating a COM file comprised of a copy-paste (provided your terminal emulator supports
this) of the entirety of the PAK, then executing your COM file. You must then issue the LICENSE
LOAD command to make the license(s) active on your system. If you choose to register your PAKs
now, you must manually type the values for each of the fields exactly as they appear in the PAK for
each license you wish to register. The licenses will be loaded automatically when the installation has
completed and the system has finished rebooting.

19. Next, you will see the Do you want to install DECwindows Motif for OpenVMS
X86-64 V1.8? prompt. DECWindows Motif is a graphical user interface for VSI OpenVMS. The
answer is up to you, because it depends on how you plan to use your VSI OpenVMS setup.

20. Next, you will be prompted about installing DECnet products which allow OpenVMS systems to
communicate and share resources with each other.

First, you will see the Do you want to install DECnet-Plus for OpenVMS
X86-64 V9.2-E? promt. If you answer NO, you will see the Do you want to install
DECnet Phase IV for OpenVMS X86-64 V9.2-2? prompt. Note that you cannot
install both products. Your choice to install one of them or neither of them depends on how you plan
to use your VSI OpenVMS setup.

21. Give an answer to the Do you always want detailed descriptions? question. The
answer is entirely up to you. As an example, we will say NO.

22. The product kit validation will proceed, and then the configuration phase starts. Then, you will see
the Do you want the defaults for all options? question. If you answer YES
(which is recommended), the following components will be installed or performed automatically:

● DECdtm Distributed Transaction Manager

● Support for DECnet-Plus or DECnet (Phase IV) for OpenVMS

● Programming Support:

○ Debugger Utility

○ Image Dump Utility

○ Macro libraries

○ Macro-32 Migration Compiler

○ TLB intermediary form of STARLET

○ C Header Files

○ VMS text libraries of Ada declarations

● RMS Journaling Recovery Utility
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● System Programming Support:

○ Delta Debugger

○ System Dump Analyzer Utility

○ Miscellaneous Symbol Table Files

● Utilities:

○ Phone Utility

○ XPG4 Internationalization Utilities

○ World-Wide PostScript Printing Subsystem

● Bliss Require Files

● Example Files

● Message Facility Files (HELP/MESSAGE)

● UETP Files

● DECwindows Server Support:

○ DECwindows Workstation files

○ Video fonts:

▪ 100 dots-per-inch video fonts

○ Euro base support

▪ Euro 100 dots-per-inch video fonts

● Delete any obsolete OpenVMS files

● Delete files archived by OpenVMS remedial kits

However, if you prefer not to install some of these components, answer NO, and the system will
prompt you about installing each component individually. If any subcomponent is not desired,
you must first choose to install the main component, and then you will be asked about each
subcomponent.

23. As the configuration phase progresses, some products may require the system to be rebooted.
Answer YES to the Can the system be REBOOTED after the installation
completes? question. A reboot is a necessary part of the installation process. If you answer NO,
the installtion will abort.

24. At this stage, if you previously answered NO to the Do you want the defaults for all
options? question (see above), you will see additional prompts asking you to confirm or reject
the installation of subcomponents of some of the layered products.
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25. Once the installation procedure has configured the layered products and their options, you will see
the Do you want to review the options? prompt. The answer is up to you. As an
example, we will answer NO.

26. After the Portion done: meter reaches 100%, a list of installed products will be displayed,
followed by post-installation information for some of the products. Once the system updates the
memory disk (which may take a minute), the installation procedure is complete. You will see the
Press Return to continue... prompt. Press Enter.

27. Next, you will see the VSI OpenVMS installation menu and the Enter CHOICE or ? for
help: (1/2/3/4/5/6/7/8/9/?) prompt. Enter 9 to shut down the system.

28. The system will shut down and display the **** Hit any key to reboot system
**** prompt. Press any key to reboot the system.

29. Depending on your hypervisor of choice, you will either see the VSI Boot Manager screen or the
UEFI screen. If you see the VSI Boot Manager screen, proceed to the next step.

If you see the UEFI Shell> prompt, do the following:

a. At the Shell> prompt, enter MAP FS* -B to display all the file systems available on your
VM. The -B option will display the entries one page at a time if more than a page-worth exists.

b. Find the file system for the newly installed system disk. If the correct file system is not readily
apparent, use the file system for the CD-ROM device which had the installation ISO mapped to
it.

c. At the Shell> prompt, enter, for example, FS1:\efi\vms\vms_bootmgr.

The VSI Boot Manager screen should now be displayed.

30. At the BOOTMGR> prompt, enter DEVICES. All VMS bootable devices will be listed.

31. At the BOOTMGR> prompt, enter BOOT <system_disk_name>, where <system_disk_name>
is the disk that you specified as the target disk for the OpenVMS installation (in this step). The
OpenVMS volume label for the device should be identified as the one you used for your target
device, not for the CD-ROM/DVD device. In this example, we will enter BOOT DKA0. The system
will boot up, run AUTOGEN, then automatically perform a shutdown, and reboot. Please take note of,
and investigate, any warnings that AUTOGEN may display.

32. When you see the BOOTMGR> prompt again, type DEVICES to show what bootable devices are
available, then enter BOOT <system_disk_name> one more time and wait for the system to
boot. Press Enter when you see an output similar to the one below:

33. At the Username: prompt, type in system.

34. At the Password: prompt, enter in the password that you had previously set for the SYSTEM
account (see this step).
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35. Optional: At this point, OpenVMS has successfully been installed, but certain infrequently used
system libraries are compressed to reduce the occupied disk space. All compressed libraries are
completely usable, but a small number of them perform slower in the compressed state. To increase
the performance of those libraries, VSI recommends manually expanding them via the LIBDECOMP
command procedure. To do so, enter the following command:

@SYS$UPDATE:LIBDECOMP EXPAND HELPLIB.HLB STARLET.OLB STARLET.MLB

For more information on LIBDECOMP, enter @SYS$UPDATE:LIBDECOMP HELP or refer to
the VSI OpenVMS System Manager's Manual [https://docs.vmssoftware.com/vsi-openvms-system-
manager-s-manual-volume-2-tuning-monitoring-and-complex-systems/#DECOMPLIBS].

36. You have successfully installed OpenVMS. If you did not register any of your licenses during
installation (which is recommended), you must do so now, otherwise you will not be able to use any
of the installed products.

To register your PAKs, you can either use the SYS$UPDATE:VMSLICENSE.COM procedure to
enter the data for each PAK individually, or you can create a COM file, copy the contents of all your
PAKs into it, and then execute the file by entering @fileName.COM.

After you have registered your licenses, you must enter the LICENSE LOAD command (or reboot
your VM) in order to be able to use the installed products.

You have successfully installed OpenVMS and registered your licenses. Now, you must perform several
configuration steps, as outlined in Chapter 4, "Networking Options".

3.2. Upgrading to VSI OpenVMS x86-64 V9.2-2
This section describes how to upgrade from the previous version of OpenVMS to V9.2-2.

It is not possible to upgrade VSI OpenVMS on a shadowed system disk, the procedure will always fail.
You will need to disable shadowing on the system disk before you can upgrade the operating system.

If you are utilizing a non-shadowed system disk, you can proceed directly to the upgrade procedure
Section 3.2.2, "Upgrading a Non-Shadowed System Disk".

3.2.1. Creating a Non-Shadowed Target Disk From a
Shadowed Disk
This section describes how to disable shadowing on an existing shadowed system disk, so that it can be
used as a target disk for the upgrade.

Caution

VSI strongly recommends that you make a backup copy of the system disk before upgrading it.

To disable shadowing on a system disk, follow these steps:

1. Enter the command $ @SYS$SYSTEM:SHUTDOWN to shut down the system booted from the
shadowed system disk that you want to upgrade.

2. The system will ask you several questions. Give appropriate answers, but make sure to answer NO
when asked for permission to perform an automatic reboot.
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3. Once you have shut down the system, you will need to perform a conversational (interactive) boot of
the system disk that you want to upgrade. Begin the process by entering the following command at
the UEFI Shell prompt:

Shell> fsn:\efi\vms\vms_bootmgr

where fsn is the file system associated with the shadowed system disk device that you want to
upgrade. If you do not know which file system you need, enter the command MAP FS* -B to
display all file systems available on your VM and look for the one associated with the shadowed
system disk that you want to upgrade.

4. Once you have selected the file system that you want to work with (for example, fs1) and entered
the command mentioned in the previous step, you will see the BOOTMGR> prompt.

5. On the boot manager startup screen, you will see the default boot command template, similar to the
following:

DEFAULT BOOT COMMAND: BOOT your_device 0x00 0x00000000

where 0x00 stands for the root and 0x00000000 stands for the flags that you can specify.

To perform a conversational boot, you must boot from your system disk with the root set to 0 and
the boot flag set to 1. To do so, enter the following command, which is based on the template that
you saw on your boot manager screen (bear in mind that yours might be slightly different):

BOOTMGR> BOOT your_device 0 1

You will see the SYSBOOT> prompt.

6. At the SYSBOOT> prompt, enter the following command to disable volume shadowing on your
system disk:

SYSBOOT> SET SHADOW_SYS_DISK 0

7. At the SYSBOOT> prompt, enter CONTINUE to resume the boot procedure.

8. After the boot completes, log in to the SYSTEM account.

9. Shutdown the system by entering the command $ @SYS$SYSTEM:SHUTDOWN

10. When asked whether an automatic system reboot should be performed, answer NO.

You now have a non-shadowed system disk that you can use for the upgrade. Go to Section 3.2.2,
"Upgrading a Non-Shadowed System Disk" to begin the upgrade procedure.

3.2.2. Upgrading a Non-Shadowed System Disk
To upgrade to VSI OpenVMS x86-64 V9.2-2 from VSI OpenVMS x86-64 V9.2 or V9.2-1, follow these
steps:

1. Download, unzip, and copy the VSI OpenVMS x86-64 V9.2-2 ISO file to an area that is locally
accessible to your hypervisor.

Note

VSI recommends that you make a backup copy of the system disk before you start the upgrade
procedure.
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2. In your virtual machine management application, select the virtual machine that you want to upgrade
to VSI OpenVMS x86-64 V9.2-2 and power it off. Then, bring up the screen to edit its settings.

3. Find the CD-ROM/DVD device that your virtual machine is using and change the ISO file associated
with the optical drive to the V9.2-2 ISO file.

4. Save the changes and close the settings window.

5. Power on your VM. Depending on your hypervisor of choice and the boot options settings of the
VM, you will either see the UEFI Shell> prompt:

or the VSI Boot Manager screen:

6. If you see the UEFI Shell> prompt, do the following:

a. At the Shell> prompt, enter MAP FS* -B to display the file systems available on your VM.

b. Choose the file system that maps to the VSI OpenVMS V9.2-2 ISO file. Since that ISO has been
set up as a CD-ROM, the file system that maps to it will be labeled as CDROM as well. As an
example, we will assume that the file system we want is FS0.

c. At the Shell> prompt, enter the following command:

FS0:\efi\vms\vms_bootmgr

After this, you should see the VSI Boot Manager screen.

7. At the BOOTMGR> prompt, type DEVICES to display the list of available VMS-bootable devices.
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Note

In certain scenarios, the list of devices displayed at this moment might be inaccurate. If the list does
not include the device that contains the ISO file with the new version of VSI OpenVMS, type EXIT
and, immediately after that, repeatedly press the Esc key on your keyboard until you see the KVM
boot manager screen. Once you see that screen, select the Continue option and press Enter. Then,
type DEVICES at the BOOTMGR> prompt again. Now, the list should be correct.

8. From the list, identify the device that contains the ISO file with the new version of VSI OpenVMS
(it will be labelled as a CD-ROM or DVD) and enter BOOT <device-name>. As an example,
BOOT DKA200. After the progress meter reaches 100%, you should see the following screen:

9. Establish a remote connection to your VM via a terminal emulator. There are various methods to
establish a remote connection. One of them is to connect via Telnet using the IP address of the host
system and the serial port of your VM. However, if this method does not work for you, you can also
use named pipes.

In the serial port setup of your VM guest and in your terminal utility, define your named pipe as \
\.\pipe\pipe_name, where pipe_name is simply a unique name you provide. Using named
pipes requires that your terminal utility reside on your VM host system. To use named pipes over a
different network node, you will need to use a Named Pipe Proxy server.

When the BOOTMGR> prompt appears, your terminal emulator should automatically connect to your
VM. However, if that does not happen, you can initiate command output to the serial port manually
by entering the command:

BOOTMGR> COM n

where n is the serial port number that your VM uses.

Warning

If you are utilizing VMware Workstation or VMware Fusion as your hypervisor, be advised that
virtual serial port support is not available via the GUI. For more information, refer to the Release
Notes.

Note

If you are working on KVM, you can establish a secure connection to the host via SSH, then
create serial ports and connect to them via the VIRSH command. For details, see the official
documentation for your Linux distribution.

If you are on ESXi, make sure that the port used by your VM can go through the ESXi firewall. If
you are having trouble at this stage, contact the ESXi administator in your company.
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10. Upon connecting, you should see the Enter CHOICE or ? for help:
(1/2/3/4/5/6/7/8/9/?) prompt.

Note

If this prompt does not appear, and the output appears blank or unchanging, press Enter. The prompt
should now appear. To see the OpenVMS installation menu, type ?, hit Enter, then hit Enter again.

Important

VSI OpenVMS x86-64 V9.2-2 does not support installation menu items number 3, 5, and 7. Also,
do not use item number 6, unless directly instructed otherwise.

11. If VSI X86VMS OPENSSH V8.9-1F or earlier version is not currently installed on your system, skip
this step.

Important

When upgrading to VSI OpenVMS V9.2-2, the procedure will abort if the VSIX86VMS OPENSSH
V8.9-1F or earlier product is currently installed on your system. Additional issues may occur if VSI
OpenSSH has not been properly configured.

Before you go on, make sure you know the name of the system disk you want to upgrade. If you do
not know the system disk, follow the steps below.

a. In the VSI OpenVMS installation menu, select 8 - Execute DCL commands and
procedures.

b. At the $$$ prompt, type the following command to display the list of available disks:

show devices dk

c. If you are unsure which system disk to upgrade, you may need to mount each of the local
disks individually until you locate the desired one. That system disk will be referred to as
<system_disk> later on in these instructions.

d. Type LOGOUT to return to the VSI OpenVMS installation menu.

To uninstall VSI x86VMS OpenSSH V8.9-1F or earlier product, perform the following procedure:

a. In the VSI OpenVMS installation menu, enter 6 - Remove installed products.

b. At the prompt for the target disk, enter the disk name for the <system disk> that you will be
upgrading.

c. Accept the default answer for the detailed description prompt.

d. You will see a list of installed products. Enter the item number that represents the VSI X86VMS
OPENSSH V8.9-1F or earlier product.

e. Answer YES to the Do you want to continue? question.

f. Important: Answer NO to each of the Do you want to terminate? questions.30
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g. When the product is removed, you will see the Press Return to continue... prompt.
Press Enter.

h. You will see the VSI OpenVMS installation menu.

12. Enter 1 to start the upgrade procedure.

13. Since this is an upgrade and not a fresh installation, answer PRESERVE to the Do you want to
INITIALIZE or to PRESERVE? question.

14. At the Enter device name for target disk: prompt, enter the name of the disk where
your current version of VSI OpenVMS is installed. If you are not sure which disk that is, enter ?? to
display a list of the disks with volume names.

15. You will see a message stating the current label of the selected disk. Specify whether you want to
keep the label or change it.

16. If your system does not have any patches installed that have recovery data available, skip to the next
step.

If your system does have at least one such patch installed, you will see an output informing you
of which patches have recovery data available. Then, you will see the Do you want to
continue? prompt. Answer YES.

17. At this stage, the system will output a list of installed products and state how each of the products is
going to be handled by the upgrade procedure.

If DECnet-Plus is not installed on your system, you will see a prompt to install it. The answer is up
to you. Note that if you have DECnet IV installed and choose to install DECnet Plus, DECnet IV will
be removed.

18. Give an answer to the Do you always want detailed descriptions? question. In
this example, we will answer NO.

19. The product kit validation will proceed and then the configuration phase starts. You will then see the
Do you want the defaults for all options? question. If you answer YES (which
is recommended), the following components will be installed or performed automatically:

● DECdtm Distributed Transaction Manager

● Support for DECnet-Plus or DECnet (Phase IV) for OpenVMS

● Programming Support:

○ Debugger Utility

○ Image Dump Utility

○ Macro libraries

○ Macro-32 Migration Compiler

○ TLB intermediary form of STARLET

○ C Header Files
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○ VMS text libraries of Ada declarations

● RMS Journaling Recovery Utility

● System Programming Support:

○ Delta Debugger

○ System Dump Analyzer Utility

○ Miscellaneous Symbol Table Files

● Utilities:

○ Phone Utility

○ XPG4 Internationalization Utilities

○ World-Wide PostScript Printing Subsystem

● Bliss Require Files

● Example Files

● Message Facility Files (HELP/MESSAGE)

● UETP Files

● DECwindows Server Support:

○ DECwindows Workstation files

○ Video fonts:

▪ 100 dots-per-inch video fonts

○ Euro base support

▪ Euro 100 dots-per-inch video fonts

● Delete any obsolete OpenVMS files

● Delete files archived by OpenVMS remedial kits

However, if you prefer not to install some of these components, answer NO, and the system will
prompt you about installing each component individually. If any subcomponent is not desired, you
must first choose to install the main component, and then will be asked about each subcomponent.

Note

Depending on what other components are currently installed or not installed on your system, you
might get additional prompts asking for your consent to install them.
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20. As the configuration phase starts and progresses, some of the products may require the system to be
rebooted. If you see the Can the system be REBOOTED after the installation
completes? question, always answer YES, because answering NO will abort the upgrade.

21. Once the upgrade procedure has configured the layered products and their options, you will see the
Do you want to review the options? prompt. The answer is entirely up to you. As an
example, we will answer NO.

22. As the execution phase starts and progresses, you will see several PCSI messages along with the
Do you want to continue? prompt for one or more of the products that will be installed.
Answer YES to all such prompts.

23. After the Portion done meter reaches 100%, you will see the list of installed and uninstalled
products followed by post-installation information for some of them. Once the system updates
the memory disk (which may take a minute), the upgrade procedure is complete. You will see the
Press Return to continue... prompt. Press Enter.

24. You will see the VSI OpenVMS installation menu and the Enter CHOICE or ? for help:
(1/2/3/4/5/6/7/8/9/?) prompt. Enter 9 to shut down the system.

25. The system will shut down and display the **** Hit any key to reboot system
**** prompt. Press any key to reboot the system.

26. Depending on your hypervisor of choice, you will either see the VSI Boot Manager screen, or the
UEFI screen. If you see the VSI Boot Manager screen, proceed to the next step.

If you see the UEFI Shell> prompt, do the following:

a. At the Shell> prompt, enter MAP FS* -B to display all the file systems available on your
VM. The -B option will display the entries one page at a time if more than a page-worth exists.

b. Find the file system for the newly upgraded system disk. If the correct file system is not readily
apparent, use the file system for the CD-ROM device which had the installation ISO mapped to
it.

c. At the Shell> prompt, enter, for example, FS1:\efi\vms\vms_bootmgr

The VSI Boot Manager screen should now be displayed.

27. At the BOOTMGR> prompt, type DEVICES to display the list of available VMS-bootable devices.

28. At the BOOTMGR> prompt, enter BOOT <system_disk_name>, where <system_disk_name>
is the disk that you specified as the target disk for the OpenVMS upgrade (in this step). The
OpenVMS volume label for the device should be identified as the one you used for your target
device, not for the CDROM/DVD device. In this example, we will enter BOOT DKA0. The system
will boot up, run AUTOGEN, then automatically perform a shutdown and reboot. Please take note of,
and investigate, any warnings that AUTOGEN may display.

29. When you see the BOOTMGR> prompt again, type DEVICES to show what bootable devices are
available, then enter BOOT <system_disk_name> one more time and wait for the system to
boot. Press Enter when you see an output similar to the one below:
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30. Log in to the system.

31. At this point, OpenVMS has been upgraded successfully, but certain system libraries still must be
expanded by manually running the LIBDECOMP command procedure. To expand all unexpanded
libraries, enter the following command:

@SYS$UPDATE:LIBDECOMP EXPAND ALL

For more information on LIBDECOMP, @SYS$UPDATE:LIBDECOMP HELP or refer to the VSI
OpenVMS System Manager's Manual [https://docs.vmssoftware.com/vsi-openvms-system-manager-
s-manual-volume-2-tuning-monitoring-and-complex-systems/#DECOMPLIBS].

32. Now you should register your new licenses, if necessary. To do so, you can either use the SYS
$UPDATE:VMSLICENSE.COM procedure to enter the data for each license individually, or you
can create a COM file, copy all of your license scripts into it, and then execute the file by entering
@fileName.COM. After you have registered your licenses, you must enter the LICENSE LOAD
command or reboot your VM.

You have successfully upgraded to VSI OpenVMS x86-64 V9.2-2.
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Chapter 4. Networking Options
This chapter provides information about networking options and instructions for configuring DECnet
Phase IV, VSI TCP/IP Services, and VSI OpenSSH on OpenVMS x86-64 V9.2-2.

4.1. Setting Up DECnet Phase IV
If you chose to install DECnet Phase IV, you must configure this software using the NETCONFIG
command procedure. For more information, see the DECnet for OpenVMS Guide to Networking [https://
docs.vmssoftware.com/vsi-openvms-decnet-guide-to-networking/].

Once you have configured DECnet Phase IV, edit SYS$COMMON:
[SYSMGR]SYSTARTUP_VMS.COM so that the software starts when the system reboots. You can have
the software start interactively or in batch mode by making one of the following changes:

● Locate and uncomment the line:

$!$ START/NETWORK DECNET 

So it now appears as:

$ START/NETWORK DECNET

● To start the network in a batch job (speeds up startup), locate and uncomment the line:

$!$ SUBMIT SYS$MANAGER:STARTNET.COM

So it now appears as:

$ SUBMIT SYS$MANAGER:STARTNET.COM

For more DECnet Phase IV documentation, visit VSI Documentation Portal [https://
docs.vmssoftware.com].

4.2. Configuring VSI TCP/IP Services
This section provides information on configuring VSI TCP/IP Services 6.0 with a dynamic IP address
provided by a DHCP server.

Important

The procedure below assumes you already have a network with a running DHCP server. It also assumes
that your virtual machine is running and you have established a connection to the machine via a terminal
emulator.

To configure VSI TCP/IP Services and DHCP, follow these steps:

1. At the $ prompt, enter @TCPIP$CONFIG.

2. From the Configuration options menu

Select 1 - Core environment.

3. From the VSI TCP/IP Services for OpenVMS Core Environment
Configuration Menu
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Select 2 – Interfaces.

4. From the VSI TCP/IP Services for OpenVMS Interface & Address
Configuration Menu.

Select 1 - IE0 Menu (EIA0: TwistedPair 1000mbps).

5. From the VSI TCP/IP Services for OpenVMS Interface IE0 Configuration
Menu (Node: MIKEY):

Select 3 - Enable DHCP client to manage address on IE0.

6. Answer YES to the Configure IE0 as the DHCP PRIMARY? (Y,N,HELP) question.

7. From the DHCP_CLIENT configuration options:

Select 1 - Enable service on this node.

8. Exit the VSI TCP/IP Services for OpenVMS Interface & Address
Configuration Menu.

9. Exit the VSI TCP/IP Services for OpenVMS Core Environment
Configuration Menu.

10. Exit the VSI TCP/IP Services for OpenVMS Configuration Menu.

11. Optional: To make sure everything works correctly so far, ping a known IP address. Do not close
your terminal emulator window.

4.3. Configuring VSI OpenSSH
To configure VSI OpenSSH on your VSI OpenVMS system, follow these steps:

Important

The procedure below assumes that your virtual machine is running and you have established a
connection to the machine via a terminal emulator. Additionally, it is assumed that the TCP/IP
configuration has been properly set up and is currently active.

Follow these steps:

1. To verify that TCP/IP is started, type the following command at the $ prompt:

@SYS$STARTUP:TCPIP$STARTUP

If TCP/IP services are already running, a message confirming their status will be displayed, and the
system prompt will be returned. If TCP/IP services are not currently running, they will be initiated,
and the system prompt will be displayed once they have started.

2. At the $ prompt, enter:

$ @SYS$COMMON:[OPENSSH.BIN]SSH$CREATE_ACCOUNT.COM

3. Give the default answer to the Enter default UIC group number for OpenSSH
account prompt.
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4. Enter the following commands in this order:

$ @SYS$COMMON:[OPENSSH.BIN]SSH$CREATE_STARTUP_FILE.COM
$ @SYS$COMMON:[OPENSSH.BIN]SSH$GENERATE_KEYS.COM
$ @SYS$COMMON:[OPENSSH.BIN]SSH$INSTALL_INFO.COM

Note

After entering the second command, make sure that SSH keys were generated. They will be
displayed on the screen.

5. Close the current terminal emulator window.

6. Establish a Telnet connection to the system via the IP address that was assigned to your system.

7. Login to the system.

8. Optional: Since later steps involve editing existing VMS files, we recommend entering the following
commands to set the page length and page width according to the size of your terminal window and
turn off overstrike mode:

$ SET TERMINAL/INQUIRE
$ SET TERMINAL/INSERT

9. Type in EDIT SYSTARTUP_VMS.COM

10. In the file, find and uncomment the following line:

@SYS$STARTUP:TCPIP$STARTUP.COM

11. Scroll to the end of the file and insert the following line before $ EXIT:

$ @SYS$COMMON:[OPENSSH.BIN]SSH$STARTUP.COM

12. If you are a privileged user or a system administrator/manager, enter EDIT SYLOGIN.COM to
access the system-wide file. A non-privileged user can add the required lines to their LOGIN.COM
file.

$ if f$trnlnm("SSH$ROOT", "LNM$SYSTEM_TABLE") .eqs. ""
$ then
$ write sys$output "VSI-OpenSSH is not configured. Configuring..."
$ if (f$search("SYS$STARTUP:SSH$DEFINE_ROOT") .nes. "")
$ then
$ @SYS$STARTUP:SSH$DEFINE_ROOT
$ write sys$output "...Done."
$ @SSH$ROOT:[BIN]SSH$DEFINE_COMMANDS.COM
$ else
$ write sys$output "VSI-OpenSSH seems to be missing..., make
 sure you have it installed."
$ endif
$ else
$ @SSH$ROOT:[BIN]SSH$DEFINE_COMMANDS.COM
$     write sys$output "VSI-OpenSSH is configured."
$ endif

13. Press Ctrl/Z to save the changes and close the file.

14. Enter EDIT SYLOGICALS.COM
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15. In the file, find and uncomment this block of lines:

$! DEFINE/SYSTEM/EXECUTIVE SYSUAF                    SYS$SYSTEM:SYSUAF.DAT
$! DEFINE/SYSTEM/EXECUTIVE SYSUAFALT                 SYS$SYSTEM:SYSUAFALT.DAT
$! DEFINE/SYSTEM/EXECUTIVE SYSALF                    SYS$SYSTEM:SYSALF.DAT
$! DEFINE/SYSTEM/EXECUTIVE RIGHTSLIST                SYS$SYSTEM:RIGHTSLIST.DAT
$! DEFINE/SYSTEM/EXECUTIVE NETPROXY                  SYS$SYSTEM:NETPROXY.DAT
$! DEFINE/SYSTEM/EXECUTIVE NET$PROXY                 SYS$SYSTEM:NET$PROXY.DAT
$! DEFINE/SYSTEM/EXECUTIVE NETOBJECT                 SYS$SYSTEM:NETOBJECT.DAT
$! DEFINE/SYSTEM/EXECUTIVE NETNODE_REMOTE            SYS$SYSTEM:NETNODE_REMOT`
$! DEFINE/SYSTEM/EXECUTIVE LMF$LICENSE               SYS$SYSTEM:LMF$LICENSE.L`
$! DEFINE/SYSTEM/EXECUTIVE VMSMAIL_PROFILE           SYS$SYSTEM:VMSMAIL_PROFI`
$! DEFINE/SYSTEM/EXECUTIVE VMS$OBJECTS               SYS$SYSTEM:VMS$OBJECTS.D`
$! DEFINE/SYSTEM/EXECUTIVE VMS$AUDIT_SERVER          SYS$MANAGER:VMS$AUDIT_SE`
$! DEFINE/SYSTEM/EXECUTIVE VMS$PASSWORD_HISTORY      SYS$SYSTEM:VMS$PASSWORD_`
$! DEFINE/SYSTEM/EXECUTIVE VMS$PASSWORD_DICTIONARY   SYS$LIBRARY:VMS$PASSWORD`
$! DEFINE/SYSTEM/EXECUTIVE NETNODE_UPDATE            SYS$MANAGER:NETNODE_UPDA`
$! DEFINE/SYSTEM/EXECUTIVE VMS$PASSWORD_POLICY       SYS$LIBRARY:VMS$PASSWORD`
$! DEFINE/SYSTEM/EXECUTIVE LAN$NODE_DATABASE         SYS$SYSTEM:LAN$NODE_DATA`
$! DEFINE/SYSTEM/EXECUTIVE VMS$CLASS_SCHEDULE        SYS$SYSTEM:VMS$CLASS_SCH`

16. Save and close the file.

17. Reboot the system.

18. Optional: To verify that everything has been set up correctly, try and establish an SSH connection to
your virtual machine.
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Cluster
This appendix provides instructions on how to create a VMS cluster with two Oracle VirtualBox VMs
both running on a Windows 10 system host with each using its own system disk.

Note

VSI development is providing the information in this appendix as one example of how to set up a cluster
on a virtual machine. There may be other or better ways to do this. VSI encourages our customers to find
other methods and to share them with us.

Use the following worksheet to list the names and addresses for your specific cluster environment.
Variables in monospace font are used throughout the instructions.

Item Your specific environment name

Location of the VSI OpenVMS V9.2-2 ISO file __________________________
Your node names  
  <VM1_nodename> __________________________
  <VM2_nodename> __________________________
Names for your virtual machines  
  <VM1_name> __________________________
  <VM2_name> __________________________
Names for your system and paging disks  
  <VM1_sysdisk_name> __________________________
  <VM1_paging_disk_name> __________________________
  <VM2_sysdisk_name> __________________________
  <VM2_paging_disk_name> __________________________
DECnet addresses of your virtual machines  
  <VM1_DECnet_address> __________________________
  <VM2_DECnet_address> __________________________
SCSSYSTEMID  
  <VM1_SCSSYSTEMID> __________________________
  <VM2_SCSSYSTEMID> __________________________
MAC addresses1  
  <VM1_DECnet_mac_address> __________________________
  <VM2_DECnet_mac_address> __________________________
TCP/IP addresses for your virtual machines  
  <your_domain_name> __________________________
  <VM1_TCPIP_address_1> __________________________
  <VM1_TCPIP_address_2> __________________________
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Item Your specific environment name

  <VM2_TCPIP_address_1> __________________________
  <VM2_TCPIP_address_2> __________________________
Port numbers2  
  <VM1_port_number_1> __________________________
  <VM1_port_number_2> __________________________
  <VM2_port_number_1> __________________________
  <VM2_port_number_2> __________________________
Number and password for the cluster  
  <cluster_number> __________________________
  <cluster_password> __________________________

1The pseudo-MAC address used by DECnet comprises the fixed hex digits AA-00-04-00 followed by nn-nn, that is the DECnet address in big-
endian format. For example, 01-28 -> 0x2801 -> 10241 (also SCSSYSTEMID) -> (1024 * 10) + 1 -> DECnet address 10.1.
2In this article, we are using PuTTY as terminal emulator and have ports <VM1_name> COM1, <VM1_name> COM2, <VM2_name> COM1,
<VM2_name> COM2, all using Host name 127.0.0.1, Connection Type: Raw, and ports <VM1_port_number_1>, <VM1_port_number_2>,
<VM2_port_number_1>, and <VM2_port_number_2> respectively.

A.1. Initial Preparation
Follow these steps:

1. Locate the V9.2-2 ISO file. You may have a zipped copy, which you should unzip.

2. On an existing OpenVMS system, enter these commands to create a 2GB disk file that can be
replicated as needed for each of the disks required:

 $ LD CREATE EMPTY2GBDISK.DSK/SIZE=4194304/ERASE 
 $ LD CONNECT EMPTY2GBDISK.DSK LDA EMPTY$ 
 $ INITIALIZE EMPTY$ EMPTY2GBDISK 
 $ LD DISCONNECT EMPTY$ 
 $ ZIP EMPTY2GBDISK EMPTY2GBDISK.DSK 

3. Copy the resulting EMPTY2GBDISK.ZIP file to your host system.

4. Unzip this archive four times to a folder where VirtualBox can access the DSK files. After each
Unzip, rename the resulting EMPTY2GBDISK.DSK to:

● <VM1_sysdisk_name>.DSK

● <VM1_paging_disk_name>.DSK

● <VM2_sysdisk_name>.DSK

● <VM2_paging_disk_name>.DSK

5. Make a VMDK file for each one using the following command:

vboxmanage internalcommands createrawvmdk -filename <x>.vmdk -rawdisk <x>.dsk

A.2. Creating the First Virtual Machine
Follow these steps:
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1. In the Oracle VM VirtualBox Manager window, click Machine, then New.

2. In the Name field, enter <VM1_name>. Accept the default for the Machine Folder field, set Type
to Other, and Version to Other/Unknown (64-bit).

3. Click Next. VSI recommends that you set the memory size to 6144MB, then click Next again.

4. Select Do not add a virtual hard disk, then click Create and Continue from the warning.

5. Select Settings for the new VM and click System.

6. In the Motherboard tab, uncheck Floppy and Optical, choose Chipset ICH9, and check Enable
EFI.

7. In the Processor tab, VSI recommends that you set the CPU count to at least 2.

8. Select Storage from the settings menu.

9. Click Add controller, select the AHCI (SATA) type controller. Add four disks to this controller in
the following order:

● <VM1_sysdisk_name>.VMDK (as a hard disk)

● <VM1_paging_disk_name>.VMDK (as a hard disk)

● <V9.2-2_ISO_file>.ISO (as an optical drive)

● <VM2_sysdisk_name>.VMDK (as a hard disk)

You must add each disk to the available drives first and then select it for the VM.

10. From the Settings menu, select Network.

11. Enable the first three adapters. The first adapter is used to connect to your extended network using
TCP/IP and might include a VPN. The second adapter is used to connect to your local network
(which may be entirely within your host system) using TCP/IP. The third adapter is used to connect
your virtual machines using DECnet IV. All three adapters are used for cluster communication.

12. For Adapter 1, select the NAT adapter type (default value).

Note

This setting is determined by how your computer accesses the rest of your network from the VM.
In the example described here, the target machines are connected via VPN, which requires the NAT
adapter type. If you are using a local network, change the adapter type to Bridged.

Under Advanced, make sure Adapter Type is set to Intel PRO/1000 MT Desktop (82540EM),
use default MAC address, and make sure Cable Connected is checked.

13. Adapter 2 is a Bridged Adapter; accept the default name.

Under Advanced, specify the same settings as Adapter 1 with the default MAC address, but make
sure Promiscuous is set to Deny.

14. Set up Adapter 3 the same way as Adapter 2, but override the MAC address with
<VM1_DECnet_mac_address>. This MAC address matches the DECnet address
<VM1_DECnet_address>.
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15. From the Settings menu, select Ports. With our method, two ports with distinct port numbers
are used on each system. Ports 1 and 2 are COM1 and COM2 respectively. The Port Mode is
TCP. Connect to existing pipe/socket option should be unchecked, and Path/Address are set to
<VM1_port_number_1> and <VM1_port_number_2>.

A.3. Starting the Virtual Machine
Follow these steps:

1. Start the VM that you have just set up.

2. In the Virtual Machine console window that is created, the VM boot process should stop at the
Shell> prompt. If it does not, press ESC.

3. Click View, then click Scaled Mode. Close the Virtual Machine window.

4. In the Close Virtual Machine pop-up window, select Power Off the machine, and then click OK.
This sets “Power off” as the default action on close.

5. Restart the VM.

6. Connect to your COM1 port.

7. To find the CD-ROM and invoke the Boot Manager from it, enter the map -r command at the
Shell> prompt. Because the only bootable disk is the ISO kit file, just VMS_BOOTMGR should be
sufficient.

Enable auto-boot and set Flags to 800 before entering the BOOT DKA200 command to begin the
installation. You should install to the DKA0: disk with the following settings:

1. Set the volume label to <VM1_nodename>_V92.

2. Enable hard links if you need them.

3. Set SCSNODE to <VM1_nodename>.

4. Set SCSSYSTEMID to <VM1_SCSSYSTEMID>.

8. Important: When the system reboots to perform AUTOGEN, abort AUTO BOOT and manually
boot the new system disk with the command BOOT DKA0. Once the AUTOGEN step is done and
the system boots, log in and invoke CLUSTER_CONFIG_LAN.COM, option 1.

9. Answer Yes to the SCSI bus prompt and enter <cluster_number> and <cluster_password> when
requested.

10. Answer Yes to the disk server prompt.

11. Answer No to the quorum disk prompt. Skip the port allocation class and set EXPECTED_VOTES
to 1. You can safely ignore the warnings.

12. Run AUTOGEN again and let the system reboot as a single-node cluster.

13. At this point, you should modify several of the SYSGEN parameters. Refer to the VSI OpenVMS
System Management Utilities Reference Manual [https://docs.vmssoftware.com/vsi-openvms-system-
management-utilities-reference-manual-volume-ii-m-z/#PARAMETER_DESCRIPTIONS] for the
description of MODPARAMS.DAT and update its contents and the CURRENT parameter settings.
The values used should be from the following list:
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WINDOW_SYSTEM=1 
DISK_QUORUM="" 
NISCS_LOAD_PEA0=1 
VAXCLUSTER=2 
EXPECTED_VOTES=1 
MSCP_LOAD=1 
MSCP_SERVE_ALL=5 
INTERCONNECT="NI" 
BOOTNODE="NO" 
TTY_TYPAHDSZ=512 
TTY_BUF=132 
SCSNODE="<VM1_nodename>" 
SCSSYSTEMID=<VM1_SCSSYSTEMID> 
VOTES=1  

A.4. Adding a Node Using a Copy of an
Existing System Disk
On VSI OpenVMS x86-64 systems, if you use a copy of an existing system disk as the initial system disk
of a new node that is being added to a cluster, you must perform an additional step, which is changing
the label for the memory disk. Follow these steps (which assume that the new system disk is DKA300:
and it is not already mounted):

1. Identify a system disk for VM2, <VM2_sysdisk_name>.

2. To copy DKA0: (system disk of VM1) to DKA300: (this will become system disk of VM2), type in
the following commands:

$ MOUNT/FOREIGN DKA300: 
$ BACKUP/IMAGE/IGNORE=INTERLOCK DKA0: DKA300: 

3. To be able to change the label of DKA300:, first type in the following commands:

$ DISMOUNT DKA300: 
$ MOUNT DKA300/OVERRIDE=ID 

4. Change the label to <VM2_nodename>_V92.

5. Dismount the disk again and enter:

$ MOUNT/SYSTEM DKA300: <VM2_nodename>_V92

6. Connect and mount the memory disk container file using the following commands:

$ LD CONNECT DKA300:[VMS$COMMON.SYS$LDR]SYS$MD.DSK LDM LDDEV
$ MOUNT/OVER=ID LDDEV

7. Note the label of the memory disk. It will be of the form “MD20345927FD”. Change any symbols
in the label to create a unique name. For example:

$ SET VOLUME LDDEV /LABEL=MD20345927FE 

8. This gets a unique volume label into <VM2_sysdisk_name>’s memory disk. Before dismounting
the memory disk or the system disk, update several parameters, including SCSNODE and
SCSSYSTEMID:

$ MCR SYSGEN
SYSGEN> USE LDDEV:[SYS0.SYSEXE]X86_64VMSSYS.PAR
SYSGEN> SET SCSNODE "<VM2_nodename>"
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SYSGEN> SET SCSSYSTEMID <VM2_SCSSYSTEMID>
SYSGEN> SET VOTES 0
SYSGEN> WRITE LDDEV:[SYS0.SYSEXE]X86_64VMSSYS.PAR
SYSGEN> EXIT

9. Dismount the memory disk before completing the other setup tasks for the new system disk.

$ DISMOUNT LDDEV
$ LD DISCONNECT LDDEV

A.5. Creating the Second Virtual Machine
1. Before you start, shut down and power off the VM you are currently running (VM1).

2. Go into VM1 Settings, click Storage, and remove disk <VM2_sysdisk_name> (you will need to use
that disk in the new VM).

3. The process of creating VM2 is mostly the same as VM1 (as described in Section A.2, "Creating the
First Virtual Machine"), with a few differences:

● VM’s name is <VM2_name>.

● Add three disks to its SATA controller: <VM2_sysdisk_name>.VMDK and
<VM2_paging_disk_name>.VMDK (as hard disks), and an empty optical drive.

● Under Network, set the MAC address for Adapter 3 to <VM2_DECnet_MAC_address>,
which translates to DECnet address <VM2_DECnet_address>, or SCSSYSTEMID
<VM2_SCSSYSTEMID>. (See earlier footnote).

● Under Ports, use port numbers <VM2_port_number_1> and <VM2_port_number_2>.

4. Start VM1 again. Allow it to boot completely.

5. Start VM2 and perform steps 2 through 4 from Section A.3, "Starting the Virtual Machine" of this
document, so that the default action on Close is Power Off instead of Save.

6. Restart VM2 and connect VM2’s COM1 port.

7. Locate and start the boot manager as for VM1. Enable auto-boot and set Flags to 800.

8. Then boot DKA0:.

At this point, you should have a two-node cluster running off separate system disks.

A.6. Finalizing Cluster Setup
Perform the following system management tasks as follows:

1. Initialize and mount the paging disk on each system, then create PAGEFILE.SYS and
SYSDUMP.DMP in [SYS0.SYSEXE] for each one.

2. Use 1,000,000 blocks for each file. Also, create a [SYSMGR] directory on this disk as a place to
save dumps from SDA.

On VM1, enter the following:
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$ INITIALIZE DKA100: <VM1_nodename>_PAGE
$ MOUNT/SYSTEM DKA100: <VM1_nodename>_PAGE
$ CREATE/DIRECTORY DKA100:[SYS0.SYSEXE]
$ MCR SYSGEN
SYSGEN> CREATE DKA100:[SYS0.SYSEXE]PAGEFILE.SYS/SIZE=1000000
SYSGEN> CREATE DKA100:[SYS0.SYSEXE]SYSDUMP.DMP/SIZE=1000000
SYSGEN> EXIT
$ CREATE/DIRECTORY DKA100:[SYSMGR]

Repeat these commands on VM2 using <VM2_nodename>_PAGE.

3. Edit SYPAGSWPFILES.COM to install the page file.

On VM1, type in:

$ MOUNT/SYSTEM DKA100: <VM1_NODENAME>_PAGE
$ MCR SYSGEN INSTALL DKA100:[SYS0.SYSEXE]PAGEFILE.SYS/PAGE

On VM2, type in:

$ MOUNT/SYSTEM DKA100: <VM2_NODENAME>_PAGE
$ MCR SYSGEN INSTALL DKA100:[SYS0.SYSEXE]PAGEFILE.SYS/PAGE

4. During the installation of OpenVMS, a minimal pagefile was created on the system disk. Use the
SHOW MEMORY command to confirm the exact location. You may want to delete this file (which is
now on both system disks), and you should do this by renaming the file (to PAGEFILE.TMP, for
example), then rebooting each system before deleting the renamed file.

5. To set up the dump device, enter the following command on both systems:

$ SET DUMP_OPTIONS/DEVICE=DKA100: 

6. Update MODPARAMS.DAT on each node for the changes that have been made. The following
lists are taken from the MODPARAMS contents generated by the installation and running
CLUSTER_CONFIG_LAN.COM:

Common to both nodes VM1 only VM2 only

WINDOW_SYSTEM=1

DISK_QUORUM=""

NISCS_LOAD_PEA0=1

VAXCLUSTER=2

EXPECTED_VOTES=1

MSCP_LOAD=1

MSCP_SERVE_ALL=5

INTERCONNECT="NI"

BOOTNODE="NO"

TTY_TYPAHDSZ=512

TTY_BUF=132

SCSNODE="<VM1_nodename>"

SCSSYSTEMID=

<VM1_SCSSYSTEMID>

VOTES=1

SCSNODE="<VM2_nodename>"

SCSSYSTEMID=

<VM2_SCSSYSTEMID>

VOTES=0
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Note

Some of these values may not have been set to the desired values (probably MSCP_SERVE_ALL,
TTY_TYPAHDSZ, and TTY_BUF). You need to edit both copies of MODPARAMS.DAT and use
SYSGEN to update the values in use. Do not forget to enter WRITE CURRENT.

7. To set the terminal (and any other) features you want, create a SYLOGIN.COM and/or
LOGIN.COM. Among other things, we use:

$ SET TERMINAL/WIDTH=132/PAGE=48/INSERT/INQUIRE

The values above match the PuTTY setup of the terminal window used in these instructions.

8. Set up TCP/IP Services and enter the command @TCPIP$CONFIG.COM:

● Set Domain to <your_domain_name>

● Set IE0 to <VM1_TCPIP_address_1>/24 = <VM1_nodename> and
<VM2_TCPIP_address_1>/24 = <VM2_nodename> (mask = 255.255.255.0). VirtualBox
works with 10.0.2.15 and similar addresses.

● Set IE1 to static addresses that work with your local host’s network, so you can issue a TELNET
command to each node from your local host (but leave the node name associated with IE0).
These are <VM1_TCPIP_address_2> and <VM2_TCPIP_address_2>.

● Set IE2 to “No TCP/IP”, this adapter is for DECnet.

● Set Default route to an appropriate gateway value. VirtualBox works with 10.0.2.2.

● Set DNS to your extended network’s name servers’ addresses.

● Make sure FTP and TELNET are both set as CLIENT and SERVER.

9. Set up DECnet IV using NETCONFIG.COM and start it with STARTNET.COM:

● Set <VM1_nodename> = <VM1_DECnet_address> and <VM2_nodename> =
<VM2_DECnet_address>

● Define LINE and CIRCUIT EIA-2 only (STATE ON)

● Define the other node in the NODE database.

On VM1, enter:

$ MCR NCP DEFINE NODE <VM2_DECnet_address> NAME <VM2_nodename>

On VM2, enter:

$ MCR NCP DEFINE NODE <VM1_DECnet_address> NAME <VM1_nodename> 

At this point, we have a two-node cluster, with each node running from its own system disk. Each node
has a private page/dump disk. The first node (VM1) also has the kit ISO as a third disk (optical drive).
For symmetry, the second node (VM2) also has an empty optical drive. For safety, only VM1 has a
cluster vote.
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A.7. Saving Your Cluster Setup
At this step, VSI recommends that you save the setup created on the previous steps. The following
method is the easiest way to save the current VMS cluster setup (however, note that it does not save any
of the VirtualBox VM configuration data).

Shut down and power off both nodes. Then create a ZIP file of the four DSK files:

● <VM1_sysdisk_name>.DSK

● <VM1_paging_disk_name>.DSK

● <VM2_sysdisk_name>.DSK

● <VM2_paging_disk_name>.DSK

Perform the following steps:

1. Use the CLUSTER_SHUTDOWN and POWER_OFF options in SHUTDOWN.COM. Once the virtual
machines have exited, use the host to create the ZIP file.

2. On Windows 10, open your “VirtualBox VMs” folder, select all four files, and right-click the
selection.

3. In Send to, select Compressed (Zipped) folder.

4. The ZIP file is named after one of the files, so when the ZIP file is populated, rename it.

Note

If you need to restore just one disk from here, that does not mean you have to restore all of them.
Simply navigate to the ZIP folder and drag the disk file you need back to the original folder to
overwrite it.
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Appendix B. Sample Installation
and Upgrade Logs
This appendix provides a sample installation log for VSI OpenVMS x86-64 V9.2-2 installation.

Note

Depending on the choices that you make during the installation, as well as your hypervisor of choice,
certain parts of your log might look different.

B.1. Sample Installation Log
Below is the sample installation log.
BOOTMGR> DEV

BOOTABLE DEVICES: B = BootMgr Device, V = Default VMS Boot Device

   B DKB0       (DVD) = FS1    UEFI: V9_2_2       VMS: None         1481  MB  SATA DVD

BOOTMGR> BOOT DKB0
Booting...
%VMS_BOOTMGR-I-INSTALL, Booting an OpenVMS Installation Kit...
100%

%%%%%%%%%%% VSI OpenVMS (tm) x86-64 %%%%%%%%%%%

_______________________________________________

      GRAPHICAL OUTPUT HAS BEEN SUSPENDED
      USE A TERMINAL UTILITY FOR ACCESS
_______________________________________________

VSI Primary Kernel SYSBOOT Nov  9 2023 12:17:04

%SYSBOOT-I-VMTYPE, Booting as a VMware (tm) Guest

        VMS Software, Inc. OpenVMS (TM) x86_64 Operating System, V9.2-2
                    Copyright 2023 VMS Software, Inc.

%SMP-I-CPUTRN, CPU #1 has joined the active set.
%SMP-I-CPUTRN, CPU #2 has joined the active set.
%SMP-I-CPUTRN, CPU #3 has joined the active set.

    Installing required known files...

    Configuring devices...

%EIA0, Link up: 1000 mbit, fdx, flow control (rcv only), 00-50-56-AC-99-1F

    ****************************************************************

    You can install or upgrade the OpenVMS X86-64 operating system
    or you can install or upgrade layered products that are included
    on the OpenVMS X86-64 distribution media.

    You can also execute DCL commands and procedures to perform
    "standalone" tasks, such as backing up the system disk.

    Please choose one of the following:

49



Appendix B. Sample Installation and Upgrade Logs

        1)  Upgrade, install or reconfigure OpenVMS X86-64 Version V9.2-2
        2)  Display layered products that this procedure can install
        3)  Install or upgrade layered products
        4)  Show installed products
        5)  Reconfigure installed products
        6)  Remove installed products
        7)  Find, Install or Undo patches; Show or Delete Recovery Data
        8)  Execute DCL commands and procedures
        9)  Shut down this system

Enter CHOICE or ? for help: (1/2/3/4/5/6/7/8/9/?) 1

    ***********************************************************

    This procedure will ask a series of questions.

          () - encloses acceptable answers
          [] - encloses default answers

    Type your response and press the <Return> key.  Type:

          ? - to repeat an explanation
          ^ - to change prior input (not always possible)
          Ctrl/Y - to exit the installation procedure

    There are two choices for installation/upgrade:

    Initialize - Removes all software and data files that were
        previously on the target disk and installs OpenVMS X86-64.

    Preserve -- Installs or Upgrades OpenVMS X86-64 on the target disk
        and retains all other contents of the target disk.

   * Note: You cannot use preserve to install OpenVMS X86-64 on a disk on
        which any other operating system is installed.  This includes
        implementations of OpenVMS for other architectures.

Do you want to INITIALIZE or to PRESERVE? [PRESERVE] init

    You must enter the device name for the target disk on which
    OpenVMS X86-64 will be installed.

Enter device name for target disk: (? for choices) ?

  Device Name       Device Type Name        Volume Label     Size (blocks/xB)
  ------------  -------------------------  --------------  --------------------
  DKA0:         VMware Virtual disk
  DKA100:       VMware Virtual disk

  For volume label and device size enter ??

Enter device name for target disk: (? for choices) DKA0

Enter volume label for target system disk: [X86SYS]

    OpenVMS V9.0 and later requires that the target system disk be
    initialized with On-Disk Structure Level 5 (ODS-5).

    Hard links can be enabled on ODS-5 disks.  WBEM Services for OpenVMS
    does not require hard links.  (? for more information)

Do you want to enable hard links? (Yes/No/?) y

    You have chosen to install OpenVMS X86-64 on a new disk.

    The target system disk, DKA0:, will be initialized
    with structure level 5 (ODS-5).
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    Hard links WILL be enabled.
    The disk will be labeled X86SYS.
    Any data currently on the target system disk will be lost.

Is this OK? (Yes/No) y
    Initializing and mounting target....

    Creating page file....

    You must enter a password for the SYSTEM account.

    The password must be a minimum of 15 characters in length, and
    may not exceed 31 characters.  It will be checked and verified.
    The system will not accept passwords that can be guessed easily.

    The password will not be displayed as you enter it.

Password for SYSTEM account:

Re-enter SYSTEM password for verification:

    For your system to operate properly, you must set two parameters:
    SCSNODE and SCSSYSTEMID.

    SCSNODE can be from 1 to 6 letters or numbers.  It must contain at
    least one letter.

    If you plan to use DECnex86t, SCSNODE must be the DECnet Phase IV
    node name, or the DECnet-Plus (Phase V) node synonym.

    If you have multiple OpenVMS systems, the SCSNODE on each system
    must be unique.

Enter SCSNODE: x86

    If you plan to use DECnet, SCSSYSTEMID must be set based on the
    DECnet Phase IV address.

Do you plan to use DECnet? (Yes/No) [Yes] y

    DECnet Phase IV addresses are in the format

        DECnet_area_number.DECnet_node_number

    DECnet_area_number is a number between 1 and 63.
    DECnet_node_number is a number between 1 and 1023.

    If you plan to use DECnet WITHOUT Phase IV compatible addresses,
    enter 0.0.

Enter DECnet (Phase IV) Address: [1.1] 1.478

      SCSSYSTEMID will be set to 1502.

      This was calculated as follows:

          (DECnet_area_number * 1024) + DECnet_node_number

  Configuring the Local Time Zone

TIME ZONE SPECIFICATION -- MAIN Time Zone Menu            "*" indicates a menu

  0* GMT
  1* AFRICA          17) EST             33) IRAN            49) PORTUGAL
  2* AMERICA         18) EST5EDT         34) ISRAEL          50) PRC
  3* ANTARCTICA      19* ETC             35) JAMAICA         51) PST8PDT
  4* ARCTIC          20* EUROPE          36) JAPAN           52) ROC
  5* ASIA            21) FACTORY         37) KWAJALEIN       53) ROK
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  6* ATLANTIC        22) GB-EIRE         38) LIBYA           54) SINGAPORE
  7* AUSTRALIA       23) GB              39) MET             55) TURKEY
  8* BRAZIL          24) GMT-0           40* MEXICO          56) UCT
  9* CANADA          25) GMT             41* MIDEAST         57) UNIVERSAL
 10) CET             26) GMT0            42) MST             58* US
 11* CHILE           27) GMTPLUS0        43) MST7MDT         59) UTC
 12) CST6CDT         28) GREENWICH       44) NAVAJO          60) W-SU
 13) CUBA            29) HONGKONG        45) NZ-CHAT         61) WET
 14) EET             30) HST             46) NZ              62) ZULU
 15) EGYPT           31) ICELAND         47* PACIFIC
 16) EIRE            32* INDIAN          48) POLAND

Press "Return" to redisplay, enter "=" to search or "?" for help, or
Select the number above that best represents the desired time zone: 20

EUROPE Time Zone Menu                                     "*" indicates a menu

  0* RETURN TO MAIN TIME ZONE MENU
  1) AMSTERDAM       18) HELSINKI        35) NICOSIA         52) TALLINN
  2) ANDORRA         19) ISLE_OF_MAN     36) OSLO            53) TIRANE
  3) ASTRAKHAN       20) ISTANBUL        37) PARIS           54) TIRASPOL
  4) ATHENS          21) JERSEY          38) PODGORICA       55) ULYANOVSK
  5) BELFAST         22) KALININGRAD     39) POLAND          56) UZHGOROD
  6) BELGRADE        23) KIEV            40) PORTUGAL        57) VADUZ
  7) BERLIN          24) KIROV           41) PRAGUE          58) VATICAN
  8) BRATISLAVA      25) LISBON          42) RIGA            59) VIENNA
  9) BRUSSELS        26) LJUBLJANA       43) ROME            60) VILNIUS
 10) BUCHAREST       27) LONDON          44) SAMARA          61) VOLGOGRAD
 11) BUDAPEST        28) LUXEMBOURG      45) SAN_MARINO      62) WARSAW
 12) BUSINGEN        29) MADRID          46) SARAJEVO        63) ZAGREB
 13) CHISINAU        30) MALTA           47) SARATOV         64) ZAPOROZHYE
 14) COPENHAGEN      31) MARIEHAMN       48) SIMFEROPOL      65) ZURICH
 15) DUBLIN          32) MINSK           49) SKOPJE
 16) GIBRALTAR       33) MONACO          50) SOFIA
 17) GUERNSEY        34) MOSCOW          51) STOCKHOLM

Press "Return" to redisplay, enter "=" to search or "?" for help, or
Select the number above that best represents the desired time zone: 14

You selected EUROPE / COPENHAGEN as your time zone.
Is this correct? (Yes/No) [YES]:

    Configuring the Time Differential Factor (TDF)

    Default Time Differential Factor for standard time is 1:00.
    Default Time Differential Factor for daylight saving time is 2:00.

    The Time Differential Factor (TDF) is the difference between your
    system time and Coordinated Universal Time (UTC).  UTC is similar
    in most respects to Greenwich Mean Time (GMT).

    The TDF is expressed as hours and minutes, and should be entered
    in the hh:mm format.  TDFs for the Americas will be negative
    (-3:00, -4:00, etc.); TDFs for Europe, Africa, Asia and Australia
    will be positive (1:00, 2:00, etc.).

This time zone supports daylight saving time.
Is this time zone currently on daylight saving time? (Yes/No): y

Enter the Time Differential Factor [2:00]: 1:00

    NEW SYSTEM TIME DIFFERENTIAL FACTOR = 1:00

Is this correct? [Y]: y

 If you have Product Authorization Keys (PAKs) to register,
    you can register them now.

Do you want to register any Product Authorization Keys? (Yes/No) [Yes] n
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    The following products are part of the OpenVMS installation;
    they will be installed along with the OpenVMS operating system:

        o Availability Manager (base) for OpenVMS X86-64
        o TCP/IP Services for OpenVMS X86-64
        o KERBEROS for OpenVMS X86-64
        o SSL3 V3.0-11 for OpenVMS X86-64 (based on OpenSSL V3.0.11)
        o SSL111 V1.1-1W for OpenVMS X86-64 (based on OpenSSL V1.1.1w)
        o OpenSSH for OpenVMS X86-64
        o 64-bit PERL for OpenVMS X86-64

    You can also install the following optional products along with the
    OpenVMS operating system:

        o DECwindows Motif for OpenVMS X86-64
        o DECnet-Plus for OpenVMS X86-64
        o DECnet Phase IV for OpenVMS X86-64

    If you want to change your selections, you can do so later in the
    installation by answering "NO" to the following question:

        "Do you want the defaults for all options?"

    Do you want to install DECwindows Motif for OpenVMS X86-64 V1.8?
(Yes/No) [Yes]

    The DECnet-Plus kit is provided with the OpenVMS operating system kit.
    DECnet Phase IV applications are supported by DECnet-Plus.

    DECnet Phase IV is also provided as an option.

    If you install DECnet-Plus and TCP/IP you can run DECnet
    applications over a TCP/IP network.  Please refer to the
    VSI DECnet-Plus for OpenVMS Planning Guide for information
    on running DECnet over TCP/IP.

    Do you want to install DECnet-Plus for OpenVMS X86-64 V9.2-E?
(Yes/No) [Yes]

    The installation operation can provide brief or detailed descriptions.
    In either case, you can request the detailed descriptions by typing ?.

Do you always want detailed descriptions? (Yes/No) [No]

Performing product kit validation of signed kits ...
%PCSI-I-VSIVALPASSED, validation of DMM1:[VMS$COMMON]VSI-X86VMS-VMS-V0902-2-2.PC
SI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.DWMOTIF_SUPPORT_X860922_KIT]VSI-X
86VMS-DWMOTIF_SUPPORT-V0902-2-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.AVAIL_MAN_BASE_KIT]VSI-X86VMS-AVA
IL_MAN_BASE-V0902-2-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.TCPIP]VSI-X86VMS-TCPIP-V0600-23-1
.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.SSL3]VSI-X86VMS-SSL3-V0300-11-1.P
CSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.KERBEROS]VSI-X86VMS-KERBEROS-V030
3-2A-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.SSL111]VSI-X86VMS-SSL111-V0101-1W
-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.OPENSSH]VSI-X86VMS-OPENSSH-V0809-
1G-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.PERL534]VMSPORTS-X86VMS-PERL534-T
0534-0-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.DWMOTIF]VSI-X86VMS-DWMOTIF-V0108-
-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.DECNET_PLUS]VSI-X86VMS-DECNET_PLU
S-V0902-E-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.DECNET_PHASE_IV_X860922_KIT]VSI-X
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86VMS-DECNET_PHASE_IV-V0902-2-1.PCSI$COMPRESSED;1 succeeded

The following product has been selected:
    VSI X86VMS OPENVMS V9.2-2              Platform (product suite)

Configuration phase starting ...

You will be asked to choose options, if any, for each selected product and for
any products that may be installed to satisfy software dependency requirements.

Configuring VSI X86VMS OPENVMS V9.2-2: OPENVMS and related products Platform

    Copyright 2015-2023 VMS Software, Inc.

    VMS Software, Inc.

Do you want the defaults for all options? [YES]

    Availability Manager (base) for OpenVMS X86-64

    TCP/IP Services for OpenVMS X86-64

* Product VSI X86VMS TCPIP V6.0-23 requires a system reboot.
Can the system be REBOOTED after the installation completes? [YES]

    KERBEROS for OpenVMS X86-64

    SSL3 V3.0-11 for OpenVMS X86-64 (based on OpenSSL V3.0.11)

    SSL111 V1.1-1W for OpenVMS X86-64 (based on OpenSSL V1.1.1w)

    OpenSSH for OpenVMS X86-64

    64-bit PERL for OpenVMS X86-64

Do you want to review the options? [NO]

Execution phase starting ...

The following products will be installed to destinations:
    VMSPORTS X86VMS PERL534 T5.34-0        DISK$X86SYS:[VMS$COMMON.]
    VSI X86VMS AVAIL_MAN_BASE V9.2-2       DISK$X86SYS:[VMS$COMMON.]
    VSI X86VMS DECNET_PLUS V9.2-E          DISK$X86SYS:[VMS$COMMON.]
    VSI X86VMS DWMOTIF V1.8                DISK$X86SYS:[VMS$COMMON.]
    VSI X86VMS DWMOTIF_SUPPORT V9.2-2      DISK$X86SYS:[VMS$COMMON.]
    VSI X86VMS KERBEROS V3.3-2A            DISK$X86SYS:[VMS$COMMON.]
    VSI X86VMS OPENSSH V8.9-1G             DISK$X86SYS:[VMS$COMMON.]
    VSI X86VMS OPENVMS V9.2-2              DISK$X86SYS:[VMS$COMMON.]
    VSI X86VMS SSL111 V1.1-1W              DISK$X86SYS:[VMS$COMMON.]
    VSI X86VMS SSL3 V3.0-11                DISK$X86SYS:[VMS$COMMON.]
    VSI X86VMS TCPIP V6.0-23               DISK$X86SYS:[VMS$COMMON.]
    VSI X86VMS VMS V9.2-2                  DISK$X86SYS:[VMS$COMMON.]

Portion done: 0%...10%...20%...30%...40%...50%...60%...70%

        Restoring STARTUP.NSH file(s)...

        No files restored

...80%...90%
%PCSI-I-PRCOUTPUT, output from subprocess follows ...
% - Execute SYS$MANAGER:TCPIP$CONFIG.COM to proceed with configuration of
%   VSI TCP/IP Services for OpenVMS.
%
Portion done: 100%

The following products have been installed:
    VMSPORTS X86VMS PERL534 T5.34-0        Layered Product
    VSI X86VMS AVAIL_MAN_BASE V9.2-2       Layered Product
    VSI X86VMS DECNET_PLUS V9.2-E          Layered Product
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    VSI X86VMS DWMOTIF V1.8                Layered Product
    VSI X86VMS DWMOTIF_SUPPORT V9.2-2      Layered Product
    VSI X86VMS KERBEROS V3.3-2A            Layered Product
    VSI X86VMS OPENSSH V8.9-1G             Layered Product
    VSI X86VMS OPENVMS V9.2-2              Platform (product suite)
    VSI X86VMS SSL111 V1.1-1W              Layered Product
    VSI X86VMS SSL3 V3.0-11                Layered Product
    VSI X86VMS TCPIP V6.0-23               Layered Product
    VSI X86VMS VMS V9.2-2                  Operating System

VSI X86VMS OPENVMS V9.2-2: OPENVMS and related products Platform

    VSI X86VMS TCPIP V6.0-23: VSI TCP/IP Services for OpenVMS.

      VSI X86VMS SSL3 V3.0-11: SSL3 for OpenVMS X86-64 V3.0-11 (Based on OpenSSL
 3.0.11)

        Insert the following lines in SYS$MANAGER:SYSTARTUP_VMS.COM:
            @SYS$STARTUP:SSL3$STARTUP.COM
        Insert the following lines in SYS$MANAGER:SYSHUTDWN.COM:
            @SYS$STARTUP:SSL3$SHUTDOWN.COM

        Review the Installation Guide and Release Notes for post install directi
ons.

        Review the Installation Guide and Release Notes for post upgrade verific
ation suggestions.

        Refer to SYS$HELP:SSL30-11-X86.RELEASE_NOTES for more information.

      Check the release notes for current status of the product.

    VSI X86VMS KERBEROS V3.3-2A

      Configure and set up Kerberos

      If Kerberos will be run on this system, but has not been
      used previously, you need to perform the following steps.

       o Run the Kerberos configuration procedure:

          @SYS$STARTUP:KRB$CONFIGURE.COM

       o Add the following line to SYS$MANAGER:SYSTARTUP_VMS.COM:

          $ @SYS$STARTUP:KRB$STARTUP

       o Add the following line to SYS$MANAGER:SYLOGIN.COM:

          $ @SYS$MANAGER:KRB$SYMBOLS

    VSI X86VMS SSL3 V3.0-11: SSL3 for OpenVMS X86-64 V3.0-11 (Based on OpenSSL 3
.0.11)

      Insert the following lines in SYS$MANAGER:SYSTARTUP_VMS.COM:
          @SYS$STARTUP:SSL3$STARTUP.COM
      Insert the following lines in SYS$MANAGER:SYSHUTDWN.COM:
          @SYS$STARTUP:SSL3$SHUTDOWN.COM

      Review the Installation Guide and Release Notes for post install direction
s.

      Review the Installation Guide and Release Notes for post upgrade verificat
ion suggestions.

      Refer to SYS$HELP:SSL30-11-X86.RELEASE_NOTES for more information.

    VSI X86VMS SSL111 V1.1-1W: SSL111 for OpenVMS X86-64 V1.1-1W (Based on OpenS
SL 1.1.1W)
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      Review the Installation Guide and Release Notes for post install direction
s.

      Review the Installation Guide and Release Notes for post upgrade verificat
ion suggestions.

      Refer to SYS$HELP:SSL111-W-X86.RELEASE_NOTES for more information.

    VMSPORTS X86VMS PERL534 T5.34-0

      Post-installation tasks are required for Perl for OpenVMS.

          To use the Perl provided with this kit, run the following set-up
          command procedure, assuming you installed in SYS$COMMON.

            $ @sys$common:[perl-5_34]perl_setup.com

          You may wish to put that command in SYS$MANAGER:SYLOGIN.COM to
          make Perl available to all users on the system.

          Perl includes its own help system called perldoc.  Type

            $ perldoc perldoc

          for the documentation to perldoc itself.  Type

            $ perldoc perldelta

          for the changes that are new in version T5.34-0 of Perl.

          There are many Perl-related resources on the web; point your
          browser at:

            http://www.perl.org

          to get started, and thank you for using Perl for OpenVMS.

    VSI X86VMS DECNET_PLUS V9.2-E: DECnet-Plus V9.2-E for OpenVMS X86

      Release notes are available in SYS$HELP:HPE_DECNET-Plus-V84.RELEASE_NOTES
and SYS$HELP:VSI_DECNET_OSI.RELEASE_NOTES

%PCSI-I-SYSTEM_REBOOT, executing reboot procedure ...

        Shutdown/reboot deferred when this product is
        installed as part of the O/S installation/upgrade

    Running SYS$UPDATE:SYS$MD.COM to update the memory disk...

Created memory disk DKA0:[VMS$COMMON.SYS$LDR]SYS$MD.DSK;1
        - using 221504 blocks in 1 extent with 25640 spare blocks
        - mounted on LDM3775: with volume label MD23333AF6BA
        - contains OpenVMS V9.2-2

%LD-I-UNIT, Allocated device is LDM3776:

    The installation is now complete.

    When the newly installed system is first booted, a special
    startup procedure will be run.  This procedure will:

        o  Configure the system for standalone or OpenVMS Cluster operation.
        o  Run AUTOGEN to set system parameters.
        o  Reboot the system with the newly set parameters.

    You may shut down now or continue with other operations.
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  Process X86VMS_INSTALL logged out at 29-NOV-2023 12:28:47.91

Press Return to continue...

    ****************************************************************

    You can install or upgrade the OpenVMS X86-64 operating system
    or you can install or upgrade layered products that are included
    on the OpenVMS X86-64 distribution media.

    You can also execute DCL commands and procedures to perform
    "standalone" tasks, such as backing up the system disk.

    Please choose one of the following:

        1)  Upgrade, install or reconfigure OpenVMS X86-64 Version V9.2-2
        2)  Display layered products that this procedure can install
        3)  Install or upgrade layered products
        4)  Show installed products
        5)  Reconfigure installed products
        6)  Remove installed products
        7)  Find, Install or Undo patches; Show or Delete Recovery Data
        8)  Execute DCL commands and procedures
        9)  Shut down this system

Enter CHOICE or ? for help: (1/2/3/4/5/6/7/8/9/?) 9

    Shutting down the system

VSI Dump Kernel SYSBOOT Nov  9 2023 12:17:04

** Error logs not dumped, system disk is write locked.

        SYSTEM SHUTDOWN COMPLETE

**** Hit any key to reboot system ****

Restarting the system...

Attempting to start up from:
 > EFI Virtual disk (0.0)...

Scanning devices and preparing the OpenVMS Boot Manager Build 136...

VSI OpenVMS Boot Manager: V9.2-x Build 136

  ENABLED:  Symmetric Multi-Processing
  ENABLED:  Crash Dump Processing
  ENABLED:  Console output to Legacy COM 1 Port
  ENABLED:  Using Environment ROM

  Checking Required Processor Features:
  PASSED

  BOOT MANAGER DEVICE:  DKA0
  DEFAULT BOOT COMMAND: BOOT DKB0 0x00 0x00000000

  VIRTUAL MACHINE GUEST:
  VMware (tm) No Mouse support; Use Commands or Arrow Keys

  CONNECT A REMOTE TERMINAL SESSION NOW.
  Enter the TERMINAL command for remote connection assistance.

BOOTMGR> BOOT DKA0
Booting...
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%%%%%%%%%%% VSI OpenVMS (tm) x86-64 %%%%%%%%%%%

_______________________________________________

      GRAPHICAL OUTPUT HAS BEEN SUSPENDED
      USE A TERMINAL UTILITY FOR ACCESS
_______________________________________________

VSI Primary Kernel SYSBOOT Nov  9 2023 12:17:04

%SYSBOOT-I-VMTYPE, Booting as a VMware (tm) Guest

        VMS Software, Inc. OpenVMS (TM) x86_64 Operating System, V9.2-2
                    Copyright 2023 VMS Software, Inc.

%DECnet-I-LOADED, network base image loaded, version = 05.92.05

%DECnet-W-ZEROLEN, length of file is zero -- SYS$SYSROOT:[SYSEXE]NET$CONFIG.DAT

%SMP-I-CPUTRN, CPU #1 has joined the active set.
%SMP-I-CPUTRN, CPU #2 has joined the active set.
%SMP-I-CPUTRN, CPU #3 has joined the active set.

    Installing required known files...

    Configuring devices...

%STARTUP-E-NOPAGFIL, No page files have been successfully installed.
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:30:37.07  %%%%%%%%%%%
Operator _X86$OPA0: has been enabled, username SYSTEM

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:30:37.07  %%%%%%%%%%%
Operator status for operator _X86$OPA0:
CENTRAL, PRINTER, TAPES, DISKS, DEVICES, CARDS, NETWORK, CLUSTER, SECURITY,
LICENSE, OPER1, OPER2, OPER3, OPER4, OPER5, OPER6, OPER7, OPER8, OPER9, OPER10,
OPER11, OPER12

%SYSTEM-I-BOOTUPGRADE, security auditing disabled
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:30:37.08  %%%%%%%%%%%
Logfile has been initialized by operator _X86$OPA0:
Logfile is X86::SYS$SYSROOT:[SYSMGR]OPERATOR.LOG;1

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:30:37.08  %%%%%%%%%%%
Operator status for operator X86::SYS$SYSROOT:[SYSMGR]OPERATOR.LOG;1
CENTRAL, PRINTER, TAPES, DISKS, DEVICES, CARDS, NETWORK, CLUSTER, SECURITY,
LICENSE, OPER1, OPER2, OPER3, OPER4, OPER5, OPER6, OPER7, OPER8, OPER9, OPER10,
OPER11, OPER12

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:30:37.15  %%%%%%%%%%%
Message from user SYSTEM on X86
%JBC-E-OPENERR, error opening SYS$COMMON:[SYSEXE]QMAN$MASTER.DAT;

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:30:37.16  %%%%%%%%%%%
Message from user SYSTEM on X86
-RMS-E-FNF, file not found

%LICENSE-F-EMTLDB, license database contains no license records
%SYSTEM-I-BOOTUPGRADE, security server not started
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:30:37.27  %%%%%%%%%%%
Message from user SYSTEM on X86
TDF-I-SETTDF TDF set new timezone differential

NET$STARTUP, Network not started due to UPGRADE boot
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:30:37.40  %%%%%%%%%%%
Message from user SYSTEM on X86
%LICENSE-E-NOAUTH, VSI OPENVMS-X86 use is not authorized on this node
-LICENSE-F-NOLICENSE, no license is active for this software product
-LICENSE-I-SYSMGR, please see your system manager
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%LICENSE-E-NOAUTH, VSI OPENVMS-X86 use is not authorized on this node
-LICENSE-F-NOLICENSE, no license is active for this software product
-LICENSE-I-SYSMGR, please see your system manager
Startup processing continuing...

%SYSTEM-I-BOOTUPGRADE, Coordinated Startup not performed
%EIA0, Link up: 1000 mbit, fdx, flow control (rcv only), 00-50-56-AC-99-1F

    AUTOGEN will now be run to compute the new system parameters.  The system
    will then shut down and reboot, and the installation or upgrade will be
    complete.

    After rebooting you can continue with such system management tasks as:

            Configuring networking software (TCP/IP Services, DECnet, other)
            Using SYS$MANAGER:CLUSTER_CONFIG.COM to create an OpenVMS Cluster
            Creating FIELD, SYSTEST and SYSTEST_CLIG accounts if needed

%AUTOGEN-I-BEGIN, GETDATA phase is beginning.
%AUTOGEN-I-NEWFILE,  Previous contents of SYS$SYSTEM:CLU$PARAMS.DAT have
  been copied to SYS$SYSTEM:CLU$PARAMS.OLD.  You may wish to purge
  SYS$SYSTEM:CLU$PARAMS.OLD.
%AUTOGEN-I-NEWFILE,  Previous contents of SYS$SYSTEM:CLU$PARAMS.DAT have
  been copied to SYS$SYSTEM:CLU$PARAMS.OLD.  You may wish to purge
  SYS$SYSTEM:CLU$PARAMS.OLD.
%AUTOGEN-I-NEWFILE,  Previous contents of SYS$SYSTEM:CLU$PARAMS.DAT have
  been copied to SYS$SYSTEM:CLU$PARAMS.OLD.  You may wish to purge
  SYS$SYSTEM:CLU$PARAMS.OLD.
%AUTOGEN-I-NEWFILE, A new version of SYS$SYSTEM:PARAMS.DAT has been created.
        You may wish to purge this file.
%AUTOGEN-I-END, GETDATA phase has successfully completed.
%AUTOGEN-I-BEGIN, GENPARAMS phase is beginning.
%AUTOGEN-I-NEWFILE, A new version of SYS$MANAGER:VMSIMAGES.DAT has been created.
        You may wish to purge this file.
%AUTOGEN-I-NEWFILE, A new version of SYS$SYSTEM:SETPARAMS.DAT has been created.
        You may wish to purge this file.
%AUTOGEN-I-END, GENPARAMS phase has successfully completed.
%AUTOGEN-I-BEGIN, GENFILES phase is beginning.
%SYSGEN-I-CREATED, SYS$SYSROOT:[SYSEXE]SYS$ERRLOG.DMP;2 created

        ** WARNING ** - The system disk would be over 90% full
           if the dump file were created with 16246458 blocks.
        No dump file modifications were made on device DKA0:.
        Dumpfile on device DKA0: will remain at 0 blocks.

******************
%AUTOGEN-W-REPORT, Warnings were detected by AUTOGEN.  Please review the
        information given in the file SYS$SYSTEM:AGEN$PARAMS.REPORT
******************

%AUTOGEN-I-REPORT, AUTOGEN has produced some informational messages which
        have been stored in the file SYS$SYSTEM:AGEN$PARAMS.REPORT.  You may
        wish to review the information in that file.

%AUTOGEN-I-END, GENFILES phase has successfully completed.
%AUTOGEN-I-BEGIN, SETPARAMS phase is beginning.
%SYSGEN-W-SETMAX, value set to maximum for parameter GH_EXEC_CODE
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:30:45.56  %%%%%%%%%%%
Message from user SYSTEM on X86
%SYSGEN-I-WRITECUR, CURRENT system parameters modified by process ID 00000023 in
to file SYS$SYSROOT_MD:[SYSEXE]X86_64VMSSYS.PAR;2

%AUTOGEN-I-SYSGEN, parameters modified
%AUTOGEN-I-END, SETPARAMS phase has successfully completed.
%AUTOGEN-I-BEGIN, REBOOT phase is beginning.

The system is shutting down to allow the system to boot with the
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generated site-specific parameters and installed images.

The system will automatically reboot after the shutdown and the
upgrade will be complete.

        SHUTDOWN -- Perform an Orderly System Shutdown
                    on node X86

%SHUTDOWN-I-BOOTCHECK, performing reboot consistency check...
%SHUTDOWN-I-CHECKOK, basic reboot consistency check completed

%SHUTDOWN-I-OPERATOR, this terminal is now an operator's console
%SHUTDOWN-I-DISLOGINS, interactive logins will now be disabled
%SET-I-INTSET, login interactive limit = 0, current interactive value = 0
%SHUTDOWN-I-STOPQUEUES, the queues on this node will now be stopped
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:30:45.85  %%%%%%%%%%%
Message from user SYSTEM on X86
%JBC-E-OPENERR, error opening SYS$COMMON:[SYSEXE]QMAN$MASTER.DAT;

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:30:45.85  %%%%%%%%%%%
Message from user SYSTEM on X86
-RMS-E-FNF, file not found

SHUTDOWN message on X86 from user SYSTEM at X86 Batch   12:30:45
X86 will shut down in 0 minutes; back up soon.  Please log off node X86.
Reboot system with AUTOGENerated parameters

%SHUTDOWN-I-STOPUSER, all user processes will now be stopped
%SHUTDOWN-I-STOPCPU, the secondary processors will now be stopped
%SMP-I-CPUTRN, CPU #1 was removed from the active set.
%SMP-I-CPUTRN, CPU #2 was removed from the active set.
%SMP-I-CPUTRN, CPU #3 was removed from the active set.
%SHUTDOWN-I-REMOVE, all installed images will now be removed
%SET-I-PSXROOSET, system POSIX root set to SYS$SYSDEVICE:[000000]
%SHUTDOWN-I-DISMOUNT, all volumes will now be dismounted
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:30:46.11  %%%%%%%%%%%
Message from user SYSTEM on X86
STARTUP, X86 shutdown was requested by the operator.

VSI Dump Kernel SYSBOOT Nov  9 2023 12:17:04

** Dumping error logs to the system disk (X86$DKA0:)
** Error logs dumped to X86$DKA0:[SYS0.SYSEXE]SYS$ERRLOG.DMP
** (used 36 out of 96 available blocks)

Restarting the system...

Attempting to start up from:
 > EFI Virtual disk (0.0)...

Scanning devices and preparing the OpenVMS Boot Manager Build 136...

VSI OpenVMS Boot Manager: V9.2-x Build 136

  ENABLED:  Symmetric Multi-Processing
  ENABLED:  Crash Dump Processing
  ENABLED:  Console output to Legacy COM 1 Port
  ENABLED:  Using Environment ROM

  Checking Required Processor Features:
  PASSED

  BOOT MANAGER DEVICE:  DKA0
  DEFAULT BOOT COMMAND: BOOT DKA0 0x00 0x00000000

  VIRTUAL MACHINE GUEST:
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  VMware (tm) No Mouse support; Use Commands or Arrow Keys

  CONNECT A REMOTE TERMINAL SESSION NOW.
  Enter the TERMINAL command for remote connection assistance.

BOOTMGR>B DKA0
Booting...

%%%%%%%%%%% VSI OpenVMS (tm) x86-64 %%%%%%%%%%%

_______________________________________________

      GRAPHICAL OUTPUT HAS BEEN SUSPENDED
      USE A TERMINAL UTILITY FOR ACCESS
_______________________________________________

VSI Primary Kernel SYSBOOT Nov  9 2023 12:17:04

%SYSBOOT-I-VMTYPE, Booting as a VMware (tm) Guest

        VMS Software, Inc. OpenVMS (TM) x86_64 Operating System, V9.2-2
                    Copyright 2023 VMS Software, Inc.

%DECnet-I-LOADED, network base image loaded, version = 05.92.05

%DECnet-W-ZEROLEN, length of file is zero -- SYS$SYSROOT:[SYSEXE]NET$CONFIG.DAT

%SMP-I-CPUTRN, CPU #1 has joined the active set.
%SMP-I-CPUTRN, CPU #2 has joined the active set.
%SMP-I-CPUTRN, CPU #3 has joined the active set.
%STDRV-I-STARTUP, OpenVMS startup begun at 29-NOV-2023 12:35:25.17
%EIA0, Link up: 1000 mbit, fdx, flow control (rcv only), 00-50-56-AC-99-1F
%RUN-S-PROC_ID, identification of created process is 00000404
%RUN-S-PROC_ID, identification of created process is 00000405
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:26.57  %%%%%%%%%%%
Operator _X86$OPA0: has been enabled, username SYSTEM

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:26.57  %%%%%%%%%%%
Operator status for operator _X86$OPA0:
CENTRAL, PRINTER, TAPES, DISKS, DEVICES, CARDS, NETWORK, CLUSTER, SECURITY,
LICENSE, OPER1, OPER2, OPER3, OPER4, OPER5, OPER6, OPER7, OPER8, OPER9, OPER10,
OPER11, OPER12

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:26.58  %%%%%%%%%%%
Logfile has been initialized by operator _X86$OPA0:
Logfile is X86::SYS$SYSROOT:[SYSMGR]OPERATOR.LOG;2

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:26.58  %%%%%%%%%%%
Operator status for operator X86::SYS$SYSROOT:[SYSMGR]OPERATOR.LOG;2
CENTRAL, PRINTER, TAPES, DISKS, DEVICES, CARDS, NETWORK, CLUSTER, SECURITY,
LICENSE, OPER1, OPER2, OPER3, OPER4, OPER5, OPER6, OPER7, OPER8, OPER9, OPER10,
OPER11, OPER12

%SET-I-NEWAUDSRV, identification of new audit server process is 0000040B
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:26.62  %%%%%%%%%%%
Message from user AUDIT$SERVER on X86
%AUDSRV-I-NEWSERVERDB, new audit server database created ( PC 00000000.8001A365)

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:26.62  %%%%%%%%%%%
Message from user AUDIT$SERVER on X86
%AUDSRV-I-REMENABLED, resource monitoring enabled for journal SECURITY

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:26.64  %%%%%%%%%%%
Message from user AUDIT$SERVER on X86
%AUDSRV-I-NEWOBJECTDB, new object database created ( PC 00000000.8001FA80)

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:26.65  %%%%%%%%%%%
Message from user SYSTEM on X86
%JBC-E-OPENERR, error opening SYS$COMMON:[SYSEXE]QMAN$MASTER.DAT;

61



Appendix B. Sample Installation and Upgrade Logs

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:26.65  %%%%%%%%%%%
Message from user SYSTEM on X86
-RMS-E-FNF, file not found

%LICENSE-F-EMTLDB, license database contains no license records
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:26.73  %%%%%%%%%%%
Message from user SYSTEM on X86
%SECSRV-I-SERVERSTARTINGU, security server starting up

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:26.73  %%%%%%%%%%%
Message from user SYSTEM on X86
%SECSRV-I-CIACRECLUDB, security server created cluster intrusion database

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:26.74  %%%%%%%%%%%
Message from user SYSTEM on X86
%SECSRV-I-CIASTARTINGUP, breakin detection and evasion processing now starting up

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:26.77  %%%%%%%%%%%
Message from user SYSTEM on X86
TDF-I-SETTDF TDF set new timezone differential

Copyright 2023 VMS Software, Inc.
%NET$STARTUP-W-NONETCONFIG, this node has not been configured to run DECnet-Plus
 for OpenVMS
        use SYS$MANAGER:NET$CONFIGURE.COM if you wish to configure DECnet
%NET$STARTUP-I-OPERSTATUS, DECnet-Plus for OpenVMS operational status is OFF
%DECdtm-F-NODECnet, the TP_SERVER process was not started because either:

o  DECnet-Plus is not started or is not configured, or

o  The SYS$NODE_FULLNAME logical name is not defined

   This could be because when you installed DECnet-Plus and were prompted
   for the system's full name, you specified a local name instead of a
   DECdns or Domain name.

If you want to use DECdtm services, make sure that DECnet-Plus is started and
configured and that SYS$NODE_FULLNAME is defined, then use the following
command to start the TP_SERVER process:

    $ @SYS$STARTUP:DECDTM$STARTUP.COM

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:27.04  %%%%%%%%%%%
Message from user SYSTEM on X86
%LICENSE-E-NOAUTH, VSI OPENVMS-X86 use is not authorized on this node
-LICENSE-F-NOLICENSE, no license is active for this software product
-LICENSE-I-SYSMGR, please see your system manager

%LICENSE-E-NOAUTH, VSI OPENVMS-X86 use is not authorized on this node
-LICENSE-F-NOLICENSE, no license is active for this software product
-LICENSE-I-SYSMGR, please see your system manager
Startup processing continuing...

%STARTUP-I-AUDITCONTINUE, audit server initialization complete
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:27.34  %%%%%%%%%%%
Message from user AUDIT$SERVER on X86
Security alarm (SECURITY) and security audit (SECURITY) on X86, system id: 1502
Auditable event:          Audit server starting up
Event time:               29-NOV-2023 12:35:27.33
PID:                      00000403
Username:                 SYSTEM

The OpenVMS system is now executing the site-specific startup commands.
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%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:27.68  %%%%%%%%%%%
Message from user AUDIT$SERVER on X86
Security alarm (SECURITY) and security audit (SECURITY) on X86, system id: 1502
Auditable event:          Identifier added
Event time:               29-NOV-2023 12:35:27.68
PID:                      00000403
Process name:             STARTUP
Username:                 SYSTEM
Process owner:            [SYSTEM]
Image name:               X86$DKA0:[SYS0.SYSCOMMON.][SYSEXE]AUTHORIZE.EXE
Identifier name:          SYS$NODE_X86
Identifier value:         %X80010000
Attributes:               none
Posix UID:                -2
Posix GID:                -2 (%XFFFFFFFE)

%UAF-I-RDBADDMSG, identifier SYS$NODE_X86 value %X80010000 added to rights datab
ase
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:27.74  %%%%%%%%%%%
Message from user AUDIT$SERVER on X86
Security alarm (SECURITY) and security audit (SECURITY) on X86, system id: 1502
Auditable event:          Identifier added
Event time:               29-NOV-2023 12:35:27.73
PID:                      00000403
Process name:             STARTUP
Username:                 SYSTEM
Process owner:            [SYSTEM]
Image name:               X86$DKA0:[SYS0.SYSCOMMON.][SYSEXE]AUTHORIZE.EXE
Identifier name:          DECW$WS_QUOTA
Identifier value:         %X80010001
Attributes:               none
Posix UID:                -2
Posix GID:                -2 (%XFFFFFFFE)

%UAF-I-RDBADDMSG, identifier DECW$WS_QUOTA value %X80010001 added to rights data
base
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:27.77  %%%%%%%%%%%
Message from user AUDIT$SERVER on X86
Security alarm (SECURITY) and security audit (SECURITY) on X86, system id: 1502
Auditable event:          Identifier added
Event time:               29-NOV-2023 12:35:27.77
PID:                      00000403
Process name:             STARTUP
Username:                 SYSTEM
Process owner:            [SYSTEM]
Image name:               X86$DKA0:[SYS0.SYSCOMMON.][SYSEXE]IMGDMP_RIGHTS.EXE;
1
Identifier name:          IMGDMP$READALL
Identifier value:         %X90390001
Attributes:               none
Posix UID:                -2
Posix GID:                -2 (%XFFFFFFFE)

%PROCDUMP-I-CREATED, rights identifier IMGDMP$READALL successfully created
%PROCDUMP-I-CREATED, rights identifier IMGDMP$PROTECT successfully created
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:27.79  %%%%%%%%%%%
Message from user AUDIT$SERVER on X86
Security alarm (SECURITY) and security audit (SECURITY) on X86, system id: 1502
Auditable event:          Identifier added
Event time:               29-NOV-2023 12:35:27.79
PID:                      00000403
Process name:             STARTUP
Username:                 SYSTEM
Process owner:            [SYSTEM]
Image name:               X86$DKA0:[SYS0.SYSCOMMON.][SYSEXE]IMGDMP_RIGHTS.EXE;
1
Identifier name:          IMGDMP$PROTECT
Identifier value:         %X90390002
Attributes:               RESOURCE
Posix UID:                -2
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Posix GID:                -2 (%XFFFFFFFE)

%SET-I-INTSET, login interactive limit = 64, current interactive value = 0
%RUN-S-PROC_ID, identification of created process is 00000411
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:27.88  %%%%%%%%%%%
Message from user SYSTEM on X86
%SMHANDLER-S-STARTUP, server management event handler startup

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:29.74  %%%%%%%%%%%
Message from user SYSTEM on X86
%SECSRV-I-PROXYSTARTINGUP, proxy processing now starting up

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:35:29.74  %%%%%%%%%%%
Message from user SYSTEM on X86
%SECSRV-E-NOPROXYDB, cannot find proxy database file NET$PROXY.DAT
%RMS-E-FNF, file not found

  SYSTEM       job terminated at 29-NOV-2023 12:35:29.89

  Accounting information:
  Buffered I/O count:               3108      Peak working set size:      13856
  Direct I/O count:                 1698      Peak virtual size:         279248
  Page faults:                      4102      Mounted volumes:                0
  Charged CPU time:        0 00:00:01.87      Elapsed time:       0 00:00:04.74

 Welcome to OpenVMS (TM) x86_64 Operating System, Version V9.2-2

Username: system
Password:
%LICENSE-I-NOLICENSE, no license is active for this software product
%LOGIN-S-LOGOPRCON, login allowed from OPA0:
VMS Software, Inc. OpenVMS (TM) x86_64 Operating System, V9.2-2

$
$ show sys/noproc/full
OpenVMS V9.2-2  on node X86   29-NOV-2023 12:35:49.28   Uptime  0 00:00:29
        VMware, Inc. VMware20,1
$

B.2. Sample Upgrade Log
Below is the sample upgrade log.

Attempting to start up from:
 > EFI Virtual disk (0.0)...

Scanning devices and preparing the OpenVMS Boot Manager...

VSI OpenVMS Boot Manager: V9.2-1 Build 128

  ENABLED:  Symmetric Multi-Processing
  ENABLED:  Crash Dump Processing
  ENABLED:  Console output to Legacy COM 1 Port
  ENABLED:  Using Environment ROM

  Checking Required Processor Features:
  PASSED

  BOOT MANAGER DEVICE:  DKA0
  DEFAULT BOOT COMMAND: BOOT DKA0 0x00 0x00000000

  VIRTUAL MACHINE GUEST:
  VMware (tm) No Mouse support; Use Commands or Arrow Keys

  CONNECT A REMOTE TERMINAL SESSION NOW.
  Enter the TERMINAL command for remote connection assistance.
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BOOTMGR> DEV

BOOTABLE DEVICES (System Disks, Installation Kits, other):

  DKA0        (HD) = FS0    UEFI: V9_2_1       VMS: X86SYS1      12288 MB  SCSI Disk
  DKB0       (DVD) = FS1    UEFI: V9_2_2       VMS: None         1481  MB  SATA DVD

BOOTMGR> BOOT DKB0
Booting...
%VMS_BOOTMGR-I-INSTALL, Booting an OpenVMS Installation Kit...
100%

%%%%%%%%%%% VSI OpenVMS (tm) x86-64 %%%%%%%%%%%

_______________________________________________

      GRAPHICAL OUTPUT HAS BEEN SUSPENDED
      USE A TERMINAL UTILITY FOR ACCESS
_______________________________________________

VSI Primary Kernel SYSBOOT Nov  9 2023 12:17:04

%SYSBOOT-I-VMTYPE, Booting as a VMware (tm) Guest

        VMS Software, Inc. OpenVMS (TM) x86_64 Operating System, V9.2-2
                    Copyright 2023 VMS Software, Inc.

%SMP-I-CPUTRN, CPU #1 has joined the active set.
%SMP-I-CPUTRN, CPU #3 has joined the active set.
%SMP-I-CPUTRN, CPU #2 has joined the active set.

    Installing required known files...

    Configuring devices...

%EIA0, Link up: 1000 mbit, fdx, flow control (rcv only), 00-50-56-AC-99-1F

    ****************************************************************

    You can install or upgrade the OpenVMS X86-64 operating system
    or you can install or upgrade layered products that are included
    on the OpenVMS X86-64 distribution media.

    You can also execute DCL commands and procedures to perform
    "standalone" tasks, such as backing up the system disk.

    Please choose one of the following:

        1)  Upgrade, install or reconfigure OpenVMS X86-64 Version V9.2-2
        2)  Display layered products that this procedure can install
        3)  Install or upgrade layered products
        4)  Show installed products
        5)  Reconfigure installed products
        6)  Remove installed products
        7)  Find, Install or Undo patches; Show or Delete Recovery Data
        8)  Execute DCL commands and procedures
        9)  Shut down this system

Enter CHOICE or ? for help: (1/2/3/4/5/6/7/8/9/?) 1
    ***********************************************************

    This procedure will ask a series of questions.

          () - encloses acceptable answers
          [] - encloses default answers

    Type your response and press the <Return> key.  Type:

          ? - to repeat an explanation
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          ^ - to change prior input (not always possible)
          Ctrl/Y - to exit the installation procedure

    There are two choices for installation/upgrade:

    Initialize - Removes all software and data files that were
        previously on the target disk and installs OpenVMS X86-64.

    Preserve -- Installs or Upgrades OpenVMS X86-64 on the target disk
        and retains all other contents of the target disk.

   * Note: You cannot use preserve to install OpenVMS X86-64 on a disk on
        which any other operating system is installed.  This includes
        implementations of OpenVMS for other architectures.

Do you want to INITIALIZE or to PRESERVE? [PRESERVE]
    You must enter the device name for the target disk on which
    OpenVMS X86-64 will be installed.

Enter device name for target disk: (? for choices) ?

  Device Name       Device Type Name        Volume Label     Size (blocks/xB)
  ------------  -------------------------  --------------  --------------------
  DKA0:         VMware Virtual disk
  DKA100:       VMware Virtual disk

  For volume label and device size enter ??

Enter device name for target disk: (? for choices) DKA0
    DKA0: is now labeled X86SYS1.

Do you want to keep this label? (Yes/No) [Yes]

    OpenVMS X86-64 will be upgraded on DKA0:.

    The following products are part of the OpenVMS installation;
    if necessary they will be installed or upgraded along with the
    OpenVMS operating system.

        o Availability Manager (base) for OpenVMS X86-64
        o TCP/IP Services for OpenVMS X86-64
        o KERBEROS for OpenVMS X86-64
        o SSL3 V3.0-11 for OpenVMS X86-64 (based on OpenSSL V3.0.11)
        o SSL111 V1.1-1W for OpenVMS X86-64 (based on OpenSSL V1.1.1w)
        o OpenSSH for OpenVMS X86-64
        o 64-bit PERL for OpenVMS X86-64

    If necessary, the following optional products will also be upgraded
    along with the OpenVMS operating system.

        o DECwindows Motif for OpenVMS X86-64
        o DECnet-Plus for OpenVMS X86-64
        o DECnet Phase IV for OpenVMS X86-64

    If you want to add or delete optional products, you can do so later
    in the upgrade by answering "NO" to the following question:

        "Do you want the defaults for all options?"

    Availability Manager (base) for OpenVMS X86-64
    is installed on your system. It will be upgraded.

    TCP/IP Services for OpenVMS X86-64
    is installed on your system. It will be upgraded.

    KERBEROS for OpenVMS X86-64 V3.3-2A
    is already installed on your system.  An upgrade is not required.

    SSL3 V3.0-11 for OpenVMS X86-64 (based on OpenSSL V3.0.11)
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    is installed on your system. It will be upgraded.

    SSL111 V1.1-1W for OpenVMS X86-64 (based on OpenSSL V1.1.1w)
    is installed on your system. It will be upgraded.

    OpenSSH for OpenVMS X86-64 is required.
    It will be installed.

    64-bit PERL for OpenVMS X86-64 T5.34-0
    is already installed on your system.  An upgrade is not required.

    DECwindows Motif for OpenVMS X86-64 V1.8
    is already installed on your system.  An upgrade is not required.

    The DECnet-Plus kit is provided with the OpenVMS operating system kit.
    DECnet Phase IV applications are supported by DECnet-Plus.

    DECnet Phase IV is also provided as an option.

    If you install DECnet-Plus and TCP/IP you can run DECnet
    applications over a TCP/IP network.  Please refer to the
    VSI DECnet-Plus for OpenVMS Planning Guide for information
    on running DECnet over TCP/IP.

    Do you want to install DECnet-Plus for OpenVMS X86-64 V9.2-E?
(Yes/No) [Yes] n

    DECnet Phase IV for OpenVMS X86-64
    is installed on your system. It will be upgraded.

    The installation operation can provide brief or detailed descriptions.
    In either case, you can request the detailed descriptions by typing ?.

Do you always want detailed descriptions? (Yes/No) [No]

    Preserving existing copies of STARTUP.NSH if found...

    No STARTUP.NSH files were found in the EFI system partition file

Performing product kit validation of signed kits ...
%PCSI-I-VSIVALPASSED, validation of DMM1:[VMS$COMMON]VSI-X86VMS-VMS-V0902-2-2.PC
SI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.DWMOTIF_SUPPORT_X860922_KIT]VSI-X
86VMS-DWMOTIF_SUPPORT-V0902-2-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.AVAIL_MAN_BASE_KIT]VSI-X86VMS-AVA
IL_MAN_BASE-V0902-2-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.TCPIP]VSI-X86VMS-TCPIP-V0600-23-1
.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.SSL3]VSI-X86VMS-SSL3-V0300-11-1.P
CSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.KERBEROS]VSI-X86VMS-KERBEROS-V030
3-2A-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.SSL111]VSI-X86VMS-SSL111-V0101-1W
-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.OPENSSH]VSI-X86VMS-OPENSSH-V0809-
1G-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.PERL534]VMSPORTS-X86VMS-PERL534-T
0534-0-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.DWMOTIF]VSI-X86VMS-DWMOTIF-V0108-
-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.DECNET_PLUS]VSI-X86VMS-DECNET_PLU
S-V0902-E-1.PCSI$COMPRESSED;1 succeeded
%PCSI-I-VSIVALPASSED, validation of DMM1:[KITS.DECNET_PHASE_IV_X860922_KIT]VSI-X
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86VMS-DECNET_PHASE_IV-V0902-2-1.PCSI$COMPRESSED;1 succeeded

The following product has been selected:
    VSI X86VMS OPENVMS V9.2-2              Platform (product suite)

Configuration phase starting ...

You will be asked to choose options, if any, for each selected product and for
any products that may be installed to satisfy software dependency requirements.

Configuring VSI X86VMS OPENVMS V9.2-2: OPENVMS and related products Platform

    Copyright 2015-2023 VMS Software, Inc.

    VMS Software, Inc.

Do you want the defaults for all options? [YES]

    Availability Manager (base) for OpenVMS X86-64

    TCP/IP Services for OpenVMS X86-64

* Product VSI X86VMS TCPIP V6.0-23 requires a system reboot.
Can the system be REBOOTED after the installation completes? [YES]

    KERBEROS for OpenVMS X86-64

    SSL3 V3.0-11 for OpenVMS X86-64 (based on OpenSSL V3.0.11)

    SSL111 V1.1-1W for OpenVMS X86-64 (based on OpenSSL V1.1.1w)

    OpenSSH for OpenVMS X86-64

    64-bit PERL for OpenVMS X86-64

Do you want to review the options? [NO]

Execution phase starting ...

%PCSI-W-VERRES, version types W through Z are reserved for VMS internal use
-PCSI-W-VERINS, the installation of product VSI X86VMS TCPIP V6.0-23
-PCSI-W-VERREM, will remove current product VSI X86VMS TCPIP X6.0-22
Do you want to continue? [YES]
The following products will be installed to destinations:
    VSI X86VMS AVAIL_MAN_BASE V9.2-2       DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS DECNET_PHASE_IV V9.2-2      DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS DWMOTIF_SUPPORT V9.2-2      DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS OPENSSH V8.9-1G             DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS OPENVMS V9.2-2              DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS SSL111 V1.1-1W              DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS SSL3 V3.0-11                DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS TCPIP V6.0-23               DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS VMS V9.2-2                  DISK$X86SYS1:[VMS$COMMON.]
The following products will be removed from destinations:
    VSI X86VMS AVAIL_MAN_BASE V9.2-1       DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS DECNET_PHASE_IV V9.2-1      DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS DWMOTIF_SUPPORT V9.2-1      DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS OPENVMS V9.2-1              DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS SSL111 V1.1-1T              DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS SSL3 V3.0-8                 DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS TCPIP X6.0-22               DISK$X86SYS1:[VMS$COMMON.]
    VSI X86VMS VMS V9.2-1                  DISK$X86SYS1:[VMS$COMMON.]

Portion done: 0%...10%...20%...30%...40%...50%...60%...70%...80%

        Restoring STARTUP.NSH file(s)...

        No files restored

...90%
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%PCSI-I-PRCOUTPUT, output from subprocess follows ...
% - Execute SYS$MANAGER:TCPIP$CONFIG.COM to proceed with configuration of
%   VSI TCP/IP Services for OpenVMS.
%
Portion done: 100%

The following products have been installed:
    VSI X86VMS AVAIL_MAN_BASE V9.2-2       Layered Product
    VSI X86VMS DECNET_PHASE_IV V9.2-2      Layered Product
    VSI X86VMS DWMOTIF_SUPPORT V9.2-2      Layered Product
    VSI X86VMS OPENSSH V8.9-1G             Layered Product
    VSI X86VMS OPENVMS V9.2-2              Platform (product suite)
    VSI X86VMS SSL111 V1.1-1W              Layered Product
    VSI X86VMS SSL3 V3.0-11                Layered Product
    VSI X86VMS TCPIP V6.0-23               Layered Product
    VSI X86VMS VMS V9.2-2                  Operating System
The following products have been removed:
    VSI X86VMS AVAIL_MAN_BASE V9.2-1       Layered Product
    VSI X86VMS DECNET_PHASE_IV V9.2-1      Layered Product
    VSI X86VMS DWMOTIF_SUPPORT V9.2-1      Layered Product
    VSI X86VMS OPENVMS V9.2-1              Platform (product suite)
    VSI X86VMS SSL111 V1.1-1T              Layered Product
    VSI X86VMS SSL3 V3.0-8                 Layered Product
    VSI X86VMS TCPIP X6.0-22               Layered Product
    VSI X86VMS VMS V9.2-1                  Operating System

VSI X86VMS OPENVMS V9.2-2: OPENVMS and related products Platform

    VSI X86VMS TCPIP V6.0-23: VSI TCP/IP Services for OpenVMS.

      VSI X86VMS SSL3 V3.0-11: SSL3 for OpenVMS X86-64 V3.0-11 (Based on OpenSSL
 3.0.11)

        Insert the following lines in SYS$MANAGER:SYSTARTUP_VMS.COM:
            @SYS$STARTUP:SSL3$STARTUP.COM
        Insert the following lines in SYS$MANAGER:SYSHUTDWN.COM:
            @SYS$STARTUP:SSL3$SHUTDOWN.COM

        Review the Installation Guide and Release Notes for post install directi
ons.

        Review the Installation Guide and Release Notes for post upgrade verific
ation suggestions.

        Refer to SYS$HELP:SSL30-11-X86.RELEASE_NOTES for more information.

      Check the release notes for current status of the product.

    VSI X86VMS SSL3 V3.0-11: SSL3 for OpenVMS X86-64 V3.0-11 (Based on OpenSSL 3
.0.11)

      Insert the following lines in SYS$MANAGER:SYSTARTUP_VMS.COM:
          @SYS$STARTUP:SSL3$STARTUP.COM
      Insert the following lines in SYS$MANAGER:SYSHUTDWN.COM:
          @SYS$STARTUP:SSL3$SHUTDOWN.COM

      Review the Installation Guide and Release Notes for post install direction
s.

      Review the Installation Guide and Release Notes for post upgrade verificat
ion suggestions.

      Refer to SYS$HELP:SSL30-11-X86.RELEASE_NOTES for more information.

    VSI X86VMS SSL111 V1.1-1W: SSL111 for OpenVMS X86-64 V1.1-1W (Based on OpenS
SL 1.1.1W)

      Review the Installation Guide and Release Notes for post install direction
s.
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      Review the Installation Guide and Release Notes for post upgrade verificat
ion suggestions.

      Refer to SYS$HELP:SSL111-W-X86.RELEASE_NOTES for more information.

%PCSI-I-SYSTEM_REBOOT, executing reboot procedure ...

        Shutdown/reboot deferred when this product is
        installed as part of the O/S installation/upgrade

%PCSI-I-SYSTEM_REBOOT, executing reboot procedure ...

    Running SYS$UPDATE:SYS$MD.COM to update the memory disk...

Created memory disk DKA0:[VMS$COMMON.SYS$LDR]SYS$MD.DSK;2
        - using 219072 blocks in 1 extent with 25629 spare blocks
        - mounted on LDM5287: with volume label MD23333A8A0B
        - contains OpenVMS V9.2-2

    The upgrade is now complete.

    When the newly upgraded system is first booted, a special
    startup procedure will be run.  This procedure will:

        o  Run AUTOGEN to set system parameters.
        o  Reboot the system with the newly set parameters.

    You may shut down now or continue with other operations.

  Process X86VMS_INSTALL logged out at 29-NOV-2023 11:59:52.16

Press Return to continue...

    ****************************************************************

    You can install or upgrade the OpenVMS X86-64 operating system
    or you can install or upgrade layered products that are included
    on the OpenVMS X86-64 distribution media.

    You can also execute DCL commands and procedures to perform
    "standalone" tasks, such as backing up the system disk.

    Please choose one of the following:

        1)  Upgrade, install or reconfigure OpenVMS X86-64 Version V9.2-2
        2)  Display layered products that this procedure can install
        3)  Install or upgrade layered products
        4)  Show installed products
        5)  Reconfigure installed products
        6)  Remove installed products
        7)  Find, Install or Undo patches; Show or Delete Recovery Data
        8)  Execute DCL commands and procedures
        9)  Shut down this system

Enter CHOICE or ? for help: (1/2/3/4/5/6/7/8/9/?) 9

    Shutting down the system

VSI Dump Kernel SYSBOOT Nov  9 2023 12:17:04

** Error logs not dumped, system disk is write locked.

        SYSTEM SHUTDOWN COMPLETE

**** Hit any key to reboot system ****
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Restarting the system...

Attempting to start up from:
 > EFI Virtual disk (0.0)...

Scanning devices and preparing the OpenVMS Boot Manager Build 136...

VSI OpenVMS Boot Manager: V9.2-x Build 136

  ENABLED:  Symmetric Multi-Processing
  ENABLED:  Crash Dump Processing
  ENABLED:  Console output to Legacy COM 1 Port
  ENABLED:  Using Environment ROM

  Checking Required Processor Features:
  PASSED

  BOOT MANAGER DEVICE:  DKA0
  DEFAULT BOOT COMMAND: BOOT DKB0 0x00 0x00000000

  VIRTUAL MACHINE GUEST:
  VMware (tm) No Mouse support; Use Commands or Arrow Keys

  CONNECT A REMOTE TERMINAL SESSION NOW.
  Enter the TERMINAL command for remote connection assistance.

BOOTMGR>
BOOTMGR> DEV

BOOTABLE DEVICES: B = BootMgr Device, V = Default VMS Boot Device

 B  DKA0        (HD) = FS0    UEFI: V9_2_2       VMS: X86SYS1      12288 MB  SCSI Disk
  V DKB0       (DVD) = FS1    UEFI: V9_2_2       VMS: None         1481  MB  SATA DVD

BOOTMGR> BOOT DKA0
Booting...
%%%%%%%%%%% VSI OpenVMS (tm) x86-64 %%%%%%%%%%%

_______________________________________________

      GRAPHICAL OUTPUT HAS BEEN SUSPENDED
      USE A TERMINAL UTILITY FOR ACCESS
_______________________________________________

VSI Primary Kernel SYSBOOT Nov  9 2023 12:17:04

%SYSBOOT-I-VMTYPE, Booting as a VMware (tm) Guest

        VMS Software, Inc. OpenVMS (TM) x86_64 Operating System, V9.2-2
                    Copyright 2023 VMS Software, Inc.

%SMP-I-CPUTRN, CPU #1 has joined the active set.
%SMP-I-CPUTRN, CPU #3 has joined the active set.
%SMP-I-CPUTRN, CPU #2 has joined the active set.

    Installing required known files...

    Configuring devices...

%STARTUP-E-NOPAGFIL, No page files have been successfully installed.
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:03:23.23  %%%%%%%%%%%
Operator _VS6126$OPA0: has been enabled, username SYSTEM

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:03:23.23  %%%%%%%%%%%
Operator status for operator _VS6126$OPA0:
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CENTRAL, PRINTER, TAPES, DISKS, DEVICES, CARDS, NETWORK, CLUSTER, SECURITY,
LICENSE, OPER1, OPER2, OPER3, OPER4, OPER5, OPER6, OPER7, OPER8, OPER9, OPER10,
OPER11, OPER12

%SYSTEM-I-BOOTUPGRADE, security auditing disabled
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:03:23.24  %%%%%%%%%%%
Logfile has been initialized by operator _VS6126$OPA0:
Logfile is VS6126::SYS$SYSROOT:[SYSMGR]OPERATOR.LOG;3

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:03:23.24  %%%%%%%%%%%
Operator status for operator VS6126::SYS$SYSROOT:[SYSMGR]OPERATOR.LOG;3
CENTRAL, PRINTER, TAPES, DISKS, DEVICES, CARDS, NETWORK, CLUSTER, SECURITY,
LICENSE, OPER1, OPER2, OPER3, OPER4, OPER5, OPER6, OPER7, OPER8, OPER9, OPER10,
OPER11, OPER12

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:03:23.27  %%%%%%%%%%%
Message from user SYSTEM on VS6126
%JBC-E-OPENERR, error opening SYS$COMMON:[SYSEXE]QMAN$MASTER.DAT;

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:03:23.27  %%%%%%%%%%%
Message from user SYSTEM on VS6126
-RMS-E-FNF, file not found

%LICENSE-F-EMTLDB, license database contains no license records
%SYSTEM-I-BOOTUPGRADE, security server not started
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:03:23.42  %%%%%%%%%%%
Message from user SYSTEM on VS6126
TDF-I-SETTDF TDF set new timezone differential

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:03:23.58  %%%%%%%%%%%
Message from user SYSTEM on VS6126
%LICENSE-E-NOAUTH, VSI OPENVMS-X86 use is not authorized on this node
-LICENSE-F-NOLICENSE, no license is active for this software product
-LICENSE-I-SYSMGR, please see your system manager

%LICENSE-E-NOAUTH, VSI OPENVMS-X86 use is not authorized on this node
-LICENSE-F-NOLICENSE, no license is active for this software product
-LICENSE-I-SYSMGR, please see your system manager
Startup processing continuing...

%SYSTEM-I-BOOTUPGRADE, Coordinated Startup not performed
%EIA0, Link up: 1000 mbit, fdx, flow control (rcv only), 00-50-56-AC-99-1F

    AUTOGEN will now be run to compute the new system parameters.  The system
    will then shut down and reboot, and the installation or upgrade will be
    complete.

    After rebooting you can continue with such system management tasks as:

            Configuring networking software (TCP/IP Services, DECnet, other)
            Using SYS$MANAGER:CLUSTER_CONFIG.COM to create an OpenVMS Cluster
            Creating FIELD, SYSTEST and SYSTEST_CLIG accounts if needed

%AUTOGEN-I-BEGIN, GETDATA phase is beginning.
%AUTOGEN-I-NEWFILE, A new version of SYS$SYSTEM:PARAMS.DAT has been created.
        You may wish to purge this file.
%AUTOGEN-I-END, GETDATA phase has successfully completed.
%AUTOGEN-I-BEGIN, GENPARAMS phase is beginning.
%AUTOGEN-I-NEWFILE, A new version of SYS$MANAGER:VMSIMAGES.DAT has been created.
        You may wish to purge this file.
%AUTOGEN-I-NEWFILE, A new version of SYS$SYSTEM:SETPARAMS.DAT has been created.
        You may wish to purge this file.
%AUTOGEN-I-END, GENPARAMS phase has successfully completed.
%AUTOGEN-I-BEGIN, GENFILES phase is beginning.
%SYSGEN-I-CREATED, SYS$SYSROOT:[SYSEXE]SYS$ERRLOG.DMP;3 created
        No dump file modifications were made on device DKA0:.
        Dumpfile on device DKA0: will remain at 16246458 blocks.

******************
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%AUTOGEN-W-REPORT, Warnings were detected by AUTOGEN.  Please review the
        information given in the file SYS$SYSTEM:AGEN$PARAMS.REPORT
******************

%AUTOGEN-I-REPORT, AUTOGEN has produced some informational messages which
        have been stored in the file SYS$SYSTEM:AGEN$PARAMS.REPORT.  You may
        wish to review the information in that file.

%AUTOGEN-I-END, GENFILES phase has successfully completed.
%AUTOGEN-I-BEGIN, SETPARAMS phase is beginning.
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:03:33.74  %%%%%%%%%%%
Message from user SYSTEM on VS6126
%SYSGEN-I-WRITECUR, CURRENT system parameters modified by process ID 00000403 in
to file SYS$SYSROOT_MD:[SYSEXE]X86_64VMSSYS.PAR;1

%AUTOGEN-I-SYSGEN, parameters modified
%AUTOGEN-I-END, SETPARAMS phase has successfully completed.
%AUTOGEN-I-BEGIN, REBOOT phase is beginning.

The system is shutting down to allow the system to boot with the
generated site-specific parameters and installed images.

The system will automatically reboot after the shutdown and the
upgrade will be complete.

        SHUTDOWN -- Perform an Orderly System Shutdown
                    on node VS6126

%SHUTDOWN-I-BOOTCHECK, performing reboot consistency check...
%SHUTDOWN-I-CHECKOK, basic reboot consistency check completed

%SHUTDOWN-I-OPERATOR, this terminal is now an operator's console
%SHUTDOWN-I-DISLOGINS, interactive logins will now be disabled
%SET-I-INTSET, login interactive limit = 0, current interactive value = 0
%SHUTDOWN-I-STOPQUEUES, the queues on this node will now be stopped
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:03:34.11  %%%%%%%%%%%
Message from user SYSTEM on VS6126
%JBC-E-OPENERR, error opening SYS$COMMON:[SYSEXE]QMAN$MASTER.DAT;

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:03:34.11  %%%%%%%%%%%
Message from user SYSTEM on VS6126
-RMS-E-FNF, file not found

SHUTDOWN message on VS6126 from user SYSTEM at VS6126 Batch   12:03:34
VS6126 will shut down in 0 minutes; back up soon.  Please log off node VS6126.
Reboot system with AUTOGENerated parameters

%SHUTDOWN-I-STOPUSER, all user processes will now be stopped
%SHUTDOWN-I-STOPCPU, the secondary processors will now be stopped
%SMP-I-CPUTRN, CPU #1 was removed from the active set.
%SMP-I-CPUTRN, CPU #2 was removed from the active set.
%SMP-I-CPUTRN, CPU #3 was removed from the active set.
%SHUTDOWN-I-REMOVE, all installed images will now be removed
%SET-I-PSXROOSET, system POSIX root set to SYS$SYSDEVICE:[000000]
%SHUTDOWN-I-DISMOUNT, all volumes will now be dismounted
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:03:34.42  %%%%%%%%%%%
Message from user SYSTEM on VS6126
STARTUP, VS6126 shutdown was requested by the operator.

VSI Dump Kernel SYSBOOT Nov  9 2023 12:17:04

** Dumping error logs to the system disk (VS6126$DKA0:)
** Error logs dumped to VS6126$DKA0:[SYS0.SYSEXE]SYS$ERRLOG.DMP
** (used 84 out of 96 available blocks)

Restarting the system...
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Attempting to start up from:
 > EFI Virtual disk (0.0)...

Scanning devices and preparing the OpenVMS Boot Manager Build 136...

VSI OpenVMS Boot Manager: V9.2-x Build 136

  ENABLED:  Symmetric Multi-Processing
  ENABLED:  Crash Dump Processing
  ENABLED:  Console output to Legacy COM 1 Port
  ENABLED:  Using Environment ROM

  Checking Required Processor Features:
  PASSED

  BOOT MANAGER DEVICE:  DKA0
  DEFAULT BOOT COMMAND: BOOT DKA0 0x00 0x00000000

  VIRTUAL MACHINE GUEST:
  VMware (tm) No Mouse support; Use Commands or Arrow Keys

  CONNECT A REMOTE TERMINAL SESSION NOW.
  Enter the TERMINAL command for remote connection assistance.

BOOTMGR> BOOT DKA0

Booting...

%%%%%%%%%%% VSI OpenVMS (tm) x86-64 %%%%%%%%%%%

_______________________________________________

      GRAPHICAL OUTPUT HAS BEEN SUSPENDED
      USE A TERMINAL UTILITY FOR ACCESS
_______________________________________________

VSI Primary Kernel SYSBOOT Nov  9 2023 12:17:04

%SYSBOOT-I-VMTYPE, Booting as a VMware (tm) Guest

        VMS Software, Inc. OpenVMS (TM) x86_64 Operating System, V9.2-2
                    Copyright 2023 VMS Software, Inc.

%SMP-I-CPUTRN, CPU #1 has joined the active set.
%SMP-I-CPUTRN, CPU #3 has joined the active set.
%SMP-I-CPUTRN, CPU #2 has joined the active set.
%STDRV-I-STARTUP, OpenVMS startup begun at 29-NOV-2023 12:04:52.20
%EIA0, Link up: 1000 mbit, fdx, flow control (rcv only), 00-50-56-AC-99-1F
%RUN-S-PROC_ID, identification of created process is 00000404
%RUN-S-PROC_ID, identification of created process is 00000405
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:53.90  %%%%%%%%%%%
Operator _VS6126$OPA0: has been enabled, username SYSTEM

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:53.90  %%%%%%%%%%%
Operator status for operator _VS6126$OPA0:
CENTRAL, PRINTER, TAPES, DISKS, DEVICES, CARDS, NETWORK, CLUSTER, SECURITY,
LICENSE, OPER1, OPER2, OPER3, OPER4, OPER5, OPER6, OPER7, OPER8, OPER9, OPER10,
OPER11, OPER12

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:53.91  %%%%%%%%%%%
Logfile has been initialized by operator _VS6126$OPA0:
Logfile is VS6126::SYS$SYSROOT:[SYSMGR]OPERATOR.LOG;4

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:53.92  %%%%%%%%%%%
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Operator status for operator VS6126::SYS$SYSROOT:[SYSMGR]OPERATOR.LOG;4
CENTRAL, PRINTER, TAPES, DISKS, DEVICES, CARDS, NETWORK, CLUSTER, SECURITY,
LICENSE, OPER1, OPER2, OPER3, OPER4, OPER5, OPER6, OPER7, OPER8, OPER9, OPER10,
OPER11, OPER12

%SET-I-NEWAUDSRV, identification of new audit server process is 0000040B
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:53.96  %%%%%%%%%%%
Message from user SYSTEM on VS6126
%JBC-E-OPENERR, error opening SYS$COMMON:[SYSEXE]QMAN$MASTER.DAT;

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:53.96  %%%%%%%%%%%
Message from user SYSTEM on VS6126
-RMS-E-FNF, file not found

%LICENSE-F-EMTLDB, license database contains no license records
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:54.05  %%%%%%%%%%%
Message from user SYSTEM on VS6126
%SECSRV-I-SERVERSTARTINGU, security server starting up

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:54.06  %%%%%%%%%%%
Message from user SYSTEM on VS6126
%SECSRV-I-CIACRECLUDB, security server created cluster intrusion database

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:54.06  %%%%%%%%%%%
Message from user SYSTEM on VS6126
%SECSRV-I-CIASTARTINGUP, breakin detection and evasion processing now starting u
p

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:54.10  %%%%%%%%%%%
Message from user SYSTEM on VS6126
TDF-I-SETTDF TDF set new timezone differential

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:54.23  %%%%%%%%%%%
Message from user SYSTEM on VS6126
Warning: DECdtm log file not found (SYS$JOURNAL:SYSTEM$VS6126.LM$JOURNAL)
        %RMS-E-FNF, file not found
        TP server process waiting

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:54.24  %%%%%%%%%%%
Message from user SYSTEM on VS6126
%LICENSE-E-NOAUTH, VSI OPENVMS-X86 use is not authorized on this node
-LICENSE-F-NOLICENSE, no license is active for this software product
-LICENSE-I-SYSMGR, please see your system manager

%LICENSE-E-NOAUTH, VSI OPENVMS-X86 use is not authorized on this node
-LICENSE-F-NOLICENSE, no license is active for this software product
-LICENSE-I-SYSMGR, please see your system manager
Startup processing continuing...

%STARTUP-I-AUDITCONTINUE, audit server initialization complete
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:54.33  %%%%%%%%%%%
Message from user AUDIT$SERVER on VS6126
Security alarm (SECURITY) and security audit (SECURITY) on VS6126, system id: 15
00
Auditable event:          Audit server starting up
Event time:               29-NOV-2023 12:04:54.31
PID:                      00000403
Username:                 SYSTEM

The OpenVMS system is now executing the site-specific startup commands.

%SET-I-INTSET, login interactive limit = 64, current interactive value = 0
%RUN-S-PROC_ID, identification of created process is 00000412
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:54.81  %%%%%%%%%%%
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Message from user SYSTEM on VS6126
%SMHANDLER-S-STARTUP, server management event handler startup

  SYSTEM       job terminated at 29-NOV-2023 12:04:56.82

  Accounting information:
  Buffered I/O count:               2936      Peak working set size:      13888
  Direct I/O count:                 1451      Peak virtual size:         278432
  Page faults:                      3791      Mounted volumes:                0
  Charged CPU time:        0 00:00:02.08      Elapsed time:       0 00:00:04.66
%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:57.06  %%%%%%%%%%%
Message from user SYSTEM on VS6126
%SECSRV-I-PROXYSTARTINGUP, proxy processing now starting up

%%%%%%%%%%%  OPCOM  29-NOV-2023 12:04:57.06  %%%%%%%%%%%
Message from user SYSTEM on VS6126
%SECSRV-E-NOPROXYDB, cannot find proxy database file NET$PROXY.DAT
%RMS-E-FNF, file not found

 Welcome to OpenVMS (TM) x86_64 Operating System, Version V9.2-2

Username: system
Password:
%LICENSE-I-NOLICENSE, no license is active for this software product
%LOGIN-S-LOGOPRCON, login allowed from OPA0:
VMS Software, Inc. OpenVMS (TM) x86_64 Operating System, V9.2-2
    Last interactive login on Wednesday, 29-NOV-2023 11:46:54.02

$ show sys/noproc/full
OpenVMS V9.2-2  on node VS6126   29-NOV-2023 12:07:11.72   Uptime  0 00:02:25
        VMware, Inc. VMware20,1
$ prod show prod
------------------------------------ ----------- ---------
PRODUCT                              KIT TYPE    STATE
------------------------------------ ----------- ---------
VMSPORTS X86VMS PERL534 T5.34-0      Full LP     Installed
VSI X86VMS AVAIL_MAN_BASE V9.2-2     Full LP     Installed
VSI X86VMS DECNET_PHASE_IV V9.2-2    Full LP     Installed
VSI X86VMS DWMOTIF V1.8              Full LP     Installed
VSI X86VMS DWMOTIF_SUPPORT V9.2-2    Full LP     Installed
VSI X86VMS KERBEROS V3.3-2A          Full LP     Installed
VSI X86VMS OPENSSH V8.9-1G           Full LP     Installed
VSI X86VMS OPENVMS V9.2-2            Platform    Installed
VSI X86VMS SSL111 V1.1-1W            Full LP     Installed
VSI X86VMS SSL3 V3.0-11              Full LP     Installed
VSI X86VMS TCPIP V6.0-23             Full LP     Installed
VSI X86VMS VMS V9.2-2                Oper System Installed
------------------------------------ ----------- ---------
12 items found
$
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